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I NTRODUCT ION

Course description

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

Course objectives

As a result of this course, you will be able to use the InEight Estimate software to:

l Construct and modify cost estimates

l Calculate profit and finalize bid proposals

How to use this manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:

Course Lessons

Lesson Topic

Lesson 1 Estimating Core Concepts

Lesson 2 General Navigation

Lesson 3 Library Setup
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Course Lessons

Lesson 4 Project Setup

Lesson 5 Estimate Direct Costs

Lesson 6 Estimate Indirect Costs

Lesson 7 Finalize the Estimate

Lesson format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the
software. For each step by step, you will use the Training Job that comes pre-
loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating
software.

Review Asks you questions to check what you have learned within each lesson.

Call-outs

Throughout the document, you will also find important call-out banners.

Tips are for important notes and information you want to remember.

Notes are for critical information you need to know.
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Ongoing use

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.

I NE IGHT EST IMATE IN THE CLOUD

InEight Estimate lets you quickly and accurately determine costs for projects of any size by using a top-
down, conceptual, and bottom-up estimating approach that lets you apply methods most appropriate
to the scope of the project. You can create realistic cost estimates using customizable templates,
standardized resource and assembly databases, and real-time benchmarking from other previous
projects.

As you create the estimate, benchmarking capabilities from InEight proactively looks for as-estimated
and as-built data points from historical projects to show you how the current estimate aligns with that
history.

Since estimates often must be presented to both owners and contractors, Estimate includes best-in-
class capabilities to roll up and visualize the estimate with tremendous flexibility, including multiple
cost breakdown structures, pay item and proposal structures, account code structures and unlimited
work breakdown structures. Estimate's user interface simplifies data entry and editing with drag and
drop for moving and copying, fill-down and multi-edit to simplify mass edits, powerful filtering and
sorting and a full audit trail to show the history of changes anyone has made to the estimate.

BUILD

Create benchmark validated estimates from high level to highly detailed using templates, resources
and cost and assembly libraries.

CONNECT

Confidently turn estimates into proposals with strategic markup and pay item pricing, alternate
scenarios and subcontractor quote management.

INNOVATE

Sync estimates with design models and project schedules to eliminate redundant data entry and gain
new competitive advantages.
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LESSON 1 — EST IMAT ING CORE
CONCEPTS

Lesson Durat ion: 30 Minutes

Lesson Object ives

After completing this lesson, you will be able to:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts
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1 . 1 OVERV IEW OF THE EST IMAT ING
PROCESS

The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you
progress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:

Note the forms used in InEight Estimate to accomplish the steps above:

l Job Properties

l Pay Item & Proposal

l CBS (Cost Breakdown Structure)

l PBS (Price Breakdown Structure)
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The rest of this section walks you through an overview of each step in the process and its
corresponding form in InEight Estimate.

Step 1 – Enter project details

When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific
settings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.

Step 2 – Enter proposal deliverables

For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.
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• Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.

Step 3 – Calculate direct and indirect project cost

Once you’ve set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.

The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity and is called a cost item
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Step 4 – Add markup, contingency, and fees

Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.
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Step 5 – Distribute cost + markup to required structure

You now have a target price or total estimated value that you can spread to your required project
deliverables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help
automatically distribute your cost, overhead and all markups to the listed items.
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1 . 2 KEY CONCEPTS AND TERMS

To help you get started in InEight Estimate, you should know a few key terms:

l Job Folder

l Library

l Form

l Cost Item

l Pay Item

l Resource

l Assembly

1.2.1 Job folder

Job folders hold all the information for an individual project estimate. It is possible to import master
data into a job folder, but when you work in a job folder it is independent, meaning any activity
performed in that folder will not affect any other jobs and will not affect the library.
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When moving back and forth between jobs, make sure to always double-check that you are in
the right job.

1.2.2 Library

The Library is a storehouse for master data, such as:

• Labor, equipment, and material unit cost rates

• Standard account codes

• Units of measure

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the library
so you must select which rates to populate a new estimate with. Four tag fields are available to filter
the resource rates you bring into an estimate from the master library. For example, you may select a
subset of your labor rates based on the geographical location of the project.

1.2.3 Form

Any screen you open in InEight Estimate is considered a Form. There are three types of forms:
Standard, Register, and Record forms.

Standard Forms resemble typical data entry forms with fields available to fill in key project
information. They also may contain radio buttons or checkboxes to define settings for the job.
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InEight Estimate uses tabs to group and organize entry fields and settings in a logical way, so
that the information is easy to access.

Register forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)
Register is an example of a register form.

In a register form, you can open a Record for individual items you want to drill into.

The Tab key is the best way to move among fields in InEight Estimate (instead of the Enter key).

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost
Breakdown Structure (CBS) Register.

InEight Inc. |  Release 26.5 Page 33 of 419

Estimate User Guide 1.2 Key concepts and terms



1.2.4 Cost item

Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a
cost item.

1.2.5 Pay item

Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
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including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
estimate value to be distributed to a structure that is different than the CBS. Pay Items are
predominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify
funding sources or for various reporting needs.

1.2.6 Resource

Resources are the building blocks of a detailed cost estimate.

Resources are the people, equipment, material, and supplies needed to complete the project.
Resources are employed to cost items to develop an estimate, and are organized into seven categories
or types:

1. Labor

2. Construction Equipment

3. Rented Construction Equipment

4. Installed Equipment

5. Installed Materials

6. Supplies

7. Unique

1.2.7 Resource assembly

A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and
excavator. When estimating, you can employ this assembly which includes all of the pre-selected
resources.
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1.2.8 Cost item assembly

A Cost Item Assembly is a predefined group of cost items that has cost based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to
reference tables. They allow companies to create intelligent construction systems to automatically
estimate various scopes of work, based upon a user providing specification and dimension variables.
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Lesson 1 - Review

1. Which InEight Estimate form is used to enter basic information about the job as well as
define our cost basis?

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. All default data and settings copy from the Library into your new job folder except:

a. Labor rates

b. Equipment rates

c. Material rates

d. All of the above

3. These are considered the “building blocks” of the job – you employ them to cost items to
develop your estimate.

a. Assemblies

b. Pay Items

c. Resources

d. Forms

Lesson 1 - Summary

As a result of this lesson, you can:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts
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LESSON 2 — NAV IGAT ION

Lesson Durat ion: 60 Minutes

Lesson Object ives

After completing this lesson, you will be able to use the following forms and explain their purpose:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers
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2 . 1 GENERAL NAV IGAT ION

As a new user to the InEight, the First-time sign in dialog box opens when you first sign in, and presents
questions about your working environment in the Project Suite environment. Preferences are set for
language, date, and number formats and the User Agreement, which you must accept before you
begin. The First-time sign in dialog boxes only show for the initial sign-in to any of the InEight products.

Estimate preferences setup

1. Select your preferred language, and then click Next.

2. Scroll to the bottom of the user agreement, and then select the check box for the terms and
conditions and privacy policy. Click Next.

Make sure you have scrolled to the end of the user agreement
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3. Select a date format and number format, and then click Next.

2 . 2 F IRST T IME ACCESS

Platform’s primary function lets you connect and share data between all Eight applications involved in
managing a project. This allows project management workflows to pass between jobsite, field office,
and front office seamlessly in a consistent and standardized user interface.

Launch Estimate

1. After selecting a project from the home page, you can access Estimate from the Main menu in
Platform by selecting Estimate, or by clicking Launch on the Estimate tile.

2. When you select Estimate from the home page for the first time, you must click Download to
access the Estimate Launcher file.
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• The EstimateLauncher.msi file downloads to your device.
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3. Click the EstimateLauncher.msi file, and then select Open. Click Next to start the one-time
Estimate Launcher setup.

4. Click Finish to complete the Estimate Launcher Setup installation. You can then open Estimate
from the Main menu or the home page.
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5. Select Estimate again to start the Estimate Launcher, which extracts the required files to launch
the Estimate application.

After setting up your Estimate preferences and installing the Estimate launcher, you can begin using
Estimate.
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Estimate subsequent use

1. Launch Estimate by selecting Estimate from the Main menu.

Estimate in the cloud looks and functions much like the Estimate on-premise version. For
example, opening a job from the landing page brings you to the Cost Breakdown Structure
register, or the register designated as the start page in the application settings.
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2.2.0 .1 Release notes summary

On your first launch of Estimate, a Release Notes dialog box shows to quickly view a summary of the
release notes. In the release notes summary dialog box, you can click the View full release notes link
to view the Release Notes page in the Knowledge Library.

2 . 3 EST IMATE RES IL IENCY

As a SaaS product, Estimate is sometimes made the casualty of server-side interruptions in service,
which are out of Estimate’s control. The auto-save function makes attempts to save your data prior to
Estimate shutting down.
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When an unexpected disruption occurs in Estimate and causes it to shut down, notifications show
alerting you of the restore process to minimize the impact on you when these interruptions occur:

l A Waiting to Reconnect notification box shows, alerting you that it is reconnecting to the server.

l When Estimate restarts, an Attention notification shows, alerting you that Estimate is being
restarted due to a service interruption.

2 . 4 BACKSTAGE V IEW

When you open Estimate, you land in the Backstage view. You can also get to the Backstage view from
other tabs, by selecting the File menu.
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Section Description

1 Create new jobs, open, save, or close opened jobs.

2 Access the library and open the Jobs page. In the Jobs page, you can access the
following options:

l Job Register
l Delete Job
l Compare Jobs
l Connected Analytics

3 Access templates, snapshots, and archive or restore options.
l Templates – Create job templates.
l Snapshots – Open the Snapshots page where you can create job snapshots
and open the Snapshot Register to access previously created snapshots.

l Archive / Restore – Open the Archive / Restore page where you can access
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Section Description

the following options:
o Archive Job
o Restore job
o Merge Jobs with Archive
o Archive Template
o Restore Template

4 Open the Settings page where you can access the following options:
l General – Customize General, Title Bars, Navigation Bar, Job Startup, and
Language options.

l Decimal Precision – Manage decimal precision for various values in
Estimate.

l Restore Defaults – Click to restore default values for selected settings.

5 Create a new job from scratch, from a template, from an existing job, or by using the
Bid Wizard..

6 View up to 10 recently opened jobs as a list or thumbnail tiles to quickly access
recently opened jobs. You can click the Favorites icon to the left of the job code to
label up to five jobs as favorites. The jobs labeled as favorites show at the top of the
list.

7 Change between the list view or tile view using the List-Tile view icon at the top
right of the section. The source for the thumbnail images in the tiles is from the
estimate project in InEight Platform. The following image shows the tile view.
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Section Description

8 Open the Job Register where you can search and open jobs that do not show in
Open a recent job list.

2.4.1 Archive / Restore

From the Backstage View, you can back up and restore your jobs using the Archive/Restore feature. For
more information, see Archive and Restore Jobs in Estimate Data Management.

2.4.2 Settings

From the Settings in the Backstage view, you can adjust some system settings. For more information,
see System Settings options.
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2.4.3 Prompt to save

An important setting to visit in the Tools menu is Prompt to Save. InEight Estimate does not
automatically save your work. Instead, it will prompt you to save as often as you specify in the general
settings.

2.4.4 Decimal precision

The Decimal Precision setting is also helpful. This is where you can specify the way your numbers
display in the system. For example, you may want your costs to display to the hundredth decimal place
(2), and your quantities to display as whole numbers with nothing to the right of the decimal (0).

Changing decimal precision does not affect the way your numbers are calculated.

2 . 5 LOAD A JOB

From the Backstage view, you can load a job by:

l Selecting a job from the Open a recent Job section.

l ClickingMore Jobs to select from the Job Register.

l Clicking Jobs from the left menu and then clicking Job Register.
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There are multiple ways to load a job from the Job Register. For more information, see Manage jobs
from the Job Register.

When you load a job, it loads into the Cost Breakdown Structure Register by default.

You can change the default form that opens when you load a job in Backstage view > Settings >
Options > General. In the Job Startup section, select a form from the Start Page drop-down list.
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In the Job Register, you can easily access a job’s properties. For more information, see Open a job’s
properties from the Job Register.

For more information about job properties, see Job properties.

2 . 6 COMMON NAV IGAT ION

Access the common navigation slide-out panel by selecting the main menu located on the top left side
of the Estimate page. This feature provides a common navigation user experience that is shared
amongst all InEight products. The primary intent of this navigation menu is to provide a consistent
InEight product experience, with similar Project Suite graphical interfaces, while working within
multiple InEight products.

Estimate's on-premise software is authenticated by your Windows login credentials, which is shown
below the main menu.
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2.6.1 Help bubbles

Help bubbles appear at various times in InEight Estimate, including the first time you open InEight
Estimate. These messages contain important information to clarify key functions in the system.

You can dismiss the message until the next time by closing it with the X in the corner or dismiss it
permanently by clicking the Never offer this help again link.
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2.6.2 Data Map

Found in the Price tab, the Data Map is a great way to view a high level summary of your estimate and
can be accessed at any time during the estimating process. You can see totals of direct costs, indirect
costs, profit, and overall bid price.

2 . 7 INE IGHT EST IMATE LAYOUT

The layout of InEight Estimate is workflow based. You will move from left to right on the tabs as you
enter your data for the project and work on developing your estimate.

2.7.1 Setup tab overview
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Section Description

1 Initialize From the initialize section, you can access the following registers. Job
Properties is where you enter the basic project details. Foundation Setup
Data is where you populate all account codes and validated fields. The
Pay item & Proposal Register provides an alternate structure to distribute
estimated values. Bid Wizard helps automate the process of setting up
estimates by copying information that already exists in other jobs.

2 Resources In the Resources section, Resource Rates opens the Resource Rate
Register, where detail costs for labor, equipment and material is stored.
The Resource Assemblies opens the Resource Assembly Register,
where you create a combination of resources as an assembly and reuse
it as needed in multiple cost items.

3 Assemblies You can create a Cost Item Assembly to automatically estimate different
scopes of work based on input values. Standard tables – allow you to
create tables of reference data that can be accessed in any cost item
assembly.

4 Reports The Reports section is available from any tab. Depending on the tab you
access it from will bring you to reports specific to that tabs data. Here
you will find reports on resources such as Resources Changes,
Resource Utilization, and Resource Cost Details.

2.7.2 Estimate tab overview

Section Description

1 Quantity
Takeoff

Import and manage quantity takeoff data using the Quantity Item
Sources, Quantity Item, and Quantity Item Employments registers.

2 Breakdown Access the Cost Breakdown Structure (CBS) Register, Account Code
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Section Description

Structures Utilization Register, and Work Breakdown Structures (WBS) Register.

3 Resources Resource Rate Register is where you create or modify the rate charged
for labor, material and equipment resources. Different views of the
Resource Rate register such as Resource Utilization and Resource
Cost Details are available from the Resources section.

4 Workbook InEight Estimate's integration with Microsoft Excel is a two-way
integration that allows you to update register fields in Estimate with data
contained in an Excel workbook, and update Excel cells with data
contained in a register field in Estimate. This is where you open the
embed excel workbook which is maintained as part of the estimate job
folder and where you preform the sync functions to send values back
and forth.

5 Schedule Access bi-directional integration with InEight Schedule, Microsoft
Project, and Oracle Primavera. The Cash Flow graph displays the
projected cash flow of your project, along with the job financing
expense, individual cost category costs and resource utilization.

6 Indirect Cost Indirect Cost Items filters the CBS register to display cost items that
contain overhead costs that are not directly associated with any
particular deliverable items. Clicking on % Price Add on or Prime Bond
opens up these individual records.

7 Overhead
and Profit

Price Breakdown Structure (PBS) Register is a visual run-down of the
costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
costs, profit and overall bid price summarized in a Data Map.

8 Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios.

9 Reports Run reports on CBS Summary, CBS Details, CBS Outline, CBS
Estimate Summary, CBS Currency Comparison.
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2.7.3 Quote tab overview

Section Description

1 Setup Quotes are organized using Address book, Quote Group Tags,
Minority Setup and attachments in the Setup section. Address book
stores and maintains all information pertaining to subcontractors,
vendors, architects/engineers, etc. that you work with regularly. The
Minority Setup tab within Job Properties stores information about the
agency that authorizes the status of Minority Enterprises along with
their different types. You can use Quote Group Tags to group together
multiple resources or cost items that will be sent in a single request for
quote package to solicited contractors or vendors..

2 Quote
Management

Quote Management allows you to access the Requests for Quote
(RFQs) register and Quotes. Request for Quotes (RFQs) are
invitations to sellers, requesting that they submit pricing to provide
services, equipment or material based on the line items and resources
included in your estimate. The Quote Register stores all of the quote
responses you receive for that job.

3 Quote
Comparison &
Award

The Quote Comparison & Award section allows you to perform
comparative analysis across all the quotes you’ve received. You can
view a comparison of submitted pricing by resources or cost items.

4 Reports From the Reports section in Quotes you can run reports on Quote
Summary, Quote Record, Compare & Award, and Minority
Participation.
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2.7.4 Price tab overview

Section Description

1 Pay Items From the Pay Items section you can lock Cost items to Pay items and
access the Pay item & Proposal register. Under Pricing in Job Properties,
you can set up how the tool calculates profit and spreads pricing to your
pay items. In the Competitors section, you can keep track of companies
that have submitted bids as well as record and track competitor bid
prices.

2 Overhead
and Profit

The Price Breakdown Structure (PBS) Register is a visual run-down of
the costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
costs, profit and overall bid price summarized in a Data Map.

3 Audit Log You can access the PBS Changes register (which logs any changes that
effect the Target Price) and turn on/off logging PBS changes..

4 Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios on the total estimate value.

5 Reports From the Reports section in the Price tab, you can generate reports for
Standard Proposal, DOT Proposal, Pay Item Summary, Pay Item
Currency Comparison, Pay Item Price Breakdown.
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2.7.5 System tab overview

Section Description

1 Custom You can customize the titles and colors for different fields. You can export
and import saved Views, Titles, Colors and Output Settings. You can
customize reports generated by Estimate using External reports. External
References allows you to open external programs with Estimate.

2 Help You can access a comprehensive help system from the Help menu. You can
get information about the Estimate Version and all new updates about the
different versions.

2.7.6 Integrations tab overview

Section Description

1 Publish Estimate
to a New Project

Sends job data to InEight Platform Integration. You can continue
using Estimate during the publish and will be notified after the data
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Section Description

has been sent successfully.

2 Publish Cost
Items to Active
Project

Sends cost items to the active project.

3 Publish Cost
Items for Change
Management

Sends cost items to InEight Platform Integration to import to InEight
Change.

4 App Logs Shows a list of InEight Project Suite application logs that you can
export to Excel.

2.7.7 Library

Click on the Library icon and the Library opens in its own window.

Users with sufficient security can access master information available in the Library.

The Library is covered in greater detail in 3.1 Library overview on page 88

2.7.8 Open forms

The following steps assume you already opened the Training Job.

Open forms

1. Click on the Setup tab.

2. In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties.
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3. Select Overview to open the Job Properties form.

l Notice that each form opens in its own tab within the active job folder

l You can tab between these forms as you are working in InEight Estimate

l Once you are in a register, the Actions and More Actions tabs are available to you. The options
available are contextual to that register
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2 . 8 SYSTEM SETT INGS OPT IONS

From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

l General settings (options)

l Title Bars

l Navigation Bar

l Job Startup

l Language

l Visual Style

All of the settings under the Options branch are user-level settings.
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The following step by step walks you through configuring general settings (options).

Decimal precision

1. With InEight Estimate open, click on the File tab to go to the Backstage view.

2. Select Settings.

3. Select General under Options in the node tree on the left.

4. To activate Prompt to Save, select the Prompt to Save checkbox.

5. Select how often you want to be prompted (in minutes).

6. Select Decimal Precision in the tree on the left.

7. Review the default settings.
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Units of Measure will default to English, and Currency will default to U.S. Dollar.

2 . 9 NAV IGAT ION

2 . 10 REG ISTERS AND COLUMNS OVERV IEW

In the Estimate registers, you can manage data to access data quickly and easily. You can do the
following in each register:

l Move columns to organize them

l Sort and filter columns to organize and view specific data

l Group columns to view the information the way you need to see it
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2 . 11 MOVE COLUMNS

You can move columns by selecting a column header and using drag-and-drop. If there are columns on
the register that you don’t use, you can hide and unhide them from view, as needed.

Move columns

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.

l The Optional Code is now hidden from view

l To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to
go.
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l You can also unhide a column using the Go To Column feature

4. Right click on a column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.

6. Click OK.

2 . 12 SORT AND F ILTER COLUMNS

You can sort and filter your columns to drill down to specific information.

InEight Inc. |  Release 26.5 Page 67 of 419

Estimate User Guide 2.12 Sort and filter columns



Sort columns

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1 to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10 to 1, Z
to A).

Use Ctrl-click to unsort a column and reset it to its original state.

Filter columns

1. In the CBS, hover over the Unit of Measure column header for the filter icon to show.

2. Click on the filter icon in the Unit of Measure column to select a filter value.

l From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).
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3. Make your selection, then click Close.

4. To clear the filter, click on the red X at the bottom of the form or click the filter icon on the
header of the column you filtered and select (All), then click OK.
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2.12.1 Filter editor overview

Column filters can be managed on individual columns or for the entire register using the Filter Editor.
The Filter Editor tool lets you work with all the column filters for a register view in one place as well as
creating more complex filters through the use of grouping and applying And/Or statements.

When you add a new Group, a new Condition is automatically added to that Group.

With each additional Condition statement, select an operator and a value in order for your customized
filter to take effect on your chosen column. Comparison operators are shown below:

2.12.1 .1 Creat ing complex f i l te rs us ing the Fi l te r Edi tor

You can define filters across any of the columns available in the CBS register. You can also open the
Filter Editor using the button in the column filter drop-down, but regardless of how you access it, the
Filter Editor dialog permits defining a filter for the entire register and not just the selected column.
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Because all the register fields are available, more complex filters can be created by using Grouping and
Or operators. In the following example, a filter has been defined to return all Terminal Cost Items that
either have a cost source of Plug, or exceed $100,000 of Total Cost (Forecast).
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When modifying a filter, the Filter Editor can be invoked by clicking the Edit Filter button located on
the bottom right of the CBS page.
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Filter editor

1. In the CBS, hover over the Unit of Measure column header for the filter icon to show.

2. Click the Filter icon in the Unit of Measure column to select a filter value, and then select a UoM.

3. Select the Filter Editor button. The Filter Editor data box shows.

l By default, an And statement is created with a Begins with operator and a blank
value.

4. Select an operator, and then enter in a value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop-down
shows.
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6. Choose which And/Or statement to add and then select the Preferred Operator.

7. Enter in your Preferred Value to complete your additional statement.

8. Click OK.

l Select the X to delete a single statement.

9. Select the And statement in the top left corner to begin clearing all And/Or statements.

10. From the drop-down, select the option Clear All.

11. When finished, select Apply, and then click OK.

2.12.2 Include subordinates filter

When applying filters in the CBS, you can select the Include subordinates option to show subordinate
items of superior items that are filtered. When selected, subordinate items under the filtered superior
items are shown even if they do not match the filtered text. This option is useful when estimating large
CBS structures where similar work shows across multiple areas, so you do not have to scroll to find and
update superior related items.

For example, when you apply a text filter using the Contains option for concrete without selecting the
Include Subordinates option, the following superior items are shown without their subordinates:
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When you use the same filter criteria and select the Include Subordinates option, the results include
the concrete superior items with their subordinates, allowing you to see everything related to the
superior items without using complex sorting and filtering.
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2 . 13 GROUP COLUMNS

Sometimes you may want to organize your information into groups. Instead of filtering your
information down to one value (e.g., unit of measure = Ton), you can look at your information with a
separate group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

Group columns

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).

l Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

2. To ungroup, right click in the grouping area and select Clear Grouping

l The column returns to its original location

You can group by more than one column to have multiple grouping levels.
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2 . 14 SAVED V IEWS

Once you have set up a view the way you like it, you can save the view so you won’t have to configure
it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Viewsmenu in the top right portion of a register.

The following steps assume you have made changes to your register view and want to save it for future
use.

Save a view

1. In the CBS register, click on the Saved views drop-down menu. The Save disc icon shows.

2. Click the Save disc icon. The Save Current View window shows.

3. Enter the View name, and then select OK. The new view shows in the drop-down menu.
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Saved views are user-specific; you will only see your own saved views when you are logged in.

2 . 15 REG ISTER RUNN ING TOTALS

You can select multiple rows in a register and see the sum total amount at the bottom of the register.

For example, you can hold down the CTRL key and multi-select cost items 2.1.1, 2.2.1, and 2.3.2 in the
CBS register, you can see the sum of the three selected cost items toward the bottom row of the
register.

Estimate calculates subtotals for quantities when the UOMs match. Superior cost items are not
included in the subtotals to avoid any double counting in the subtotal.

It is not necessary to export data to Microsoft Excel and run separate calculations to better understand
costs of multiple items. The sigma symbol shows in the subtotaled row to indicate it is the total of the
selected rows.

2 . 16 F IND FEATURE

The Find feature lets you search across all columns in the register with a single operation. The
matching results are then highlighted in yellow. A scroll bar annotation is provided to indicate the rows
in the grid containing matches. This lets you easily navigate to the search results in the register.

The Find feature also includes the flexibility to perform more precise searches using various syntax in
the search bar. The Find search bar shows the currently selected and total number of search results.
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If you type in two words, such as total cost, the grid considers them as individual conditions and
selects records that contain either total or cost.

Search Syntax Example

+ To find records that contain both search terms
like total cost, type + before the second word.
For example: total +cost.

- Type - to exclude records that contain a
specific word, for example: total-cost. You
can combine different operators. Use + and -
to select records that contain both pay and
item, excluding records that contain
assignment. For example: pay +item -
assignment.

"quotes" To search for a string that contains a space
character, you need to enclose this string in
quotation marks. For example: "total cost".

: To search against a specific column, type the
first letters of the column's display name plus
a colon character. For example: optional:
unassigned. Now the grid displays records
containing unassigned in the optional code
column.

If you add another column-specific condition, the grid joins them using the + logical operator. Then the
record shows the result that matches both options. The same happens when you join a column-specific
condition with the one applied to all columns. An example of this search criteria looks like this:
optional: unassigned +"pay item".

Find feature

1. From the Cost Breakdown Structure (CBS) Register, bring up the Find feature using CTRL+F.

2. In the search bar, type inMaterials.
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3. When all the searches are highlighted in yellow, use the up or down arrows to the right of the
search bar to navigate to the next search result in the register.

4. To add the Find feature to the register functions header, select the Options icon to the far
right of the search bar. Then select Always Expanded.

5. To search in a specific column only, select the Options icon to the far right of the search
bar. Then select Search in Selected Column Only. Search a specific term in your
selected column.

6. To close the Find functionality, click the Close icon to the left of the search bar. You can
also hold down the Shift key and then select the F3 key to use this feature.

A drop-down can be used to see a list of previous searches.

2 . 17 KEYBOARD SHORTCUTS

2.17.1 Navigating in a register

Press To

Arrow keys Move one cell up, down, left, or right
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Press To

Tab Move to the next cell in the same row

SHIFT+Tab Move to the previous cell in the same row

Home Move to the beginning of the cell

End Move to the end of the cell

Page Down Move to the last row in the register

ALT+Down Arrow Shows the contents of drop-down list choices for applicable fields

Numpad * Expands the subordinate leaves of a tree structure for the currently
highlighted branch

Numpad + key Expands the currently highlighted section to display subordinate
sections

Numpad - key Collapses the currently highlighted section to remove the display
of subordinate sections

CTRL+Spacebar Selects and Deselects a row

CTRL+Tab Toggles the display of open windows

ALT Activates form menus

ALT+F4 Closes active form

CTRL+G Opens the Go To Column navigator

2.17.2 Navigating in a record

Press To

Left and right arrow keys Move one character left or right in an editable field

TAB Move to the next editable field in the record

SHIFT+TAB Move to the previous editable field in the record

Home Move to the beginning of the field

End Move to the end of the field
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Press To

ALT+Down Arrow Shows the contents of drop-down list choices for applicable fields

F4 Shows the contents of drop-down list choices for applicable fields

CTRL+Spacebar Selects and deselects a row

CTRL+TAB Toggles the display of open windows

ALT Activates form menus

ALT+F4 Closes active form

CTRL+G Opens the Go To Column navigator

2.17.3 Menu and keystroke commands

All forms have their own set of commands specific to the form. Commands for a form show in the
ribbon on contextual tabs (Actions and More Actions) when it is open and the form is active. Click a
command on the tab to order it. Some routine commands can be ordered using the standard Windows
keystroke combinations (e.g., Ctrl+C, Ctrl+V) or right-click with the mouse when the field is selected.

2.17.4 Function keys in Estimate

Key Function

F1 Open to the Help

F2 (grid) Edit cell value: Enter edit mode for cells that are editable on the grid

F2 (tree list) Edit cell value: Enter edit mode for cells that are editable on the tree list

F3 Find next: Finds the next value based on the search criteria

F4 (grid) Show selection register or options in the drop down

F5 Refresh, wherever available

F5 Collapse subordinate Items

F6 Expand subordinate Items
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In the Account Code Utilization Register, F5 can either refresh or collapse subordinates based on
whether an account code is selected.
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Lesson 2 - Review

1. The _________ is a great way to get a summary view of your bid. You can see totals of
direct costs, indirect costs, profit and the overall bid price.

a. Job Folder

b. Data Map

c. System tab

d. Resource Rate Register

2. You can group by more than one column to have multiple grouping levels.

1. True

2. False

3. Display settings for Units of Measure, Currency, and Colors can be adjusted from the
_______ tab.

a. Setup

b. Estimate

c. System

d. Help

Lesson 2 - Summary

As a result of this lesson, you can:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers
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LESSON 3 — L IBRARY SETUP

Lesson Durat ion: 60 minutes

Lesson Object ives

After completing this lesson, you will be able to use the following forms and explain their purpose:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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3 . 1 L IBRARY OVERV IEW

The Library is where you set up and maintain master information that imports into your projects,
including resource rates, tags, units of measure, cost item assemblies, and master breakdown
structures. It is also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click the Library button to open.

You can also access the Library by clicking the Library icon, when on the InEight Estimate landing page.
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When the Library opens, you see ribbons available under the main menu tabs. Each menu tab has
unique sections which hold the necessary forms.

3.1.1 Library tabs

The Library has four tabs which organizes the forms under sections:

l Setup

l Estimate

l System

l Integrations

The Actions and More Actions tabs show when you open a register and contain functions for the
register you have active.

3.1.1 .1 Setup tab

The following image and table show an overview of the Setup tab:

Name Description

1 Job
Properties

The job properties maintained in the library will serve as the default
settings for any new estimate that is created from scratch. When
creating a new job it will inherit all the job properties set in the master
library.

2 Foundation
Setup Data

A master set of account codes, tags, and units of measure. When a
new folder is created, the master set is automatically copied from the
Library to the new folder.

InEight Inc. |  Release 26.5 Page 89 of 419

Estimate User Guide 3.1 Library overview



Name Description

3 Address Book Used to store and maintain all information pertaining to the companies
with whom you work and contact regularly (subcontractors, vendors,
architects, etc.).

4 Trench
Calculator

Stores and maintains common trench configurations that are used
from project to project.

5 Shift Rate
Calculator

Allows you to set up shift rate configurations that you can access at the
project level.

6 Resources Opens the Library Resource Rate Register where you can create and
edit all resources and resource cost details available for import into
your projects.

7 Most Used
Resources

For quick access to the Labor, Equipment and Materials tabs of the
Master Resource Rate Register.

8 Resource
Assemblies

Takes you to the Library Resource Assembly Register where you can
set up resource assemblies to import into individual projects.

9 Cost Item
Assemblies

Cost Item Assemblies are predictive models to quickly and accurately
estimate elements of a job that can be repetitive in nature on the job or
from job to job.

10 Standard
Tables

The Standard Tables are used to create and/or list job-level table data
that is accessible by any of the Cost Item Assemblies that exist in a
job. The Standard Table Record allows the user to create and or
modify a Table record. The Standard Table Register lists all the job
level tables created / available in the project.

11 User Roles Opens the User Roles Register that shows user role names and their
description which you can use in the Access Control Register.

12 Access
Control

Allows you to customize your system permissions by restricting
destinations or commands that only designated roles should have
access to.

13 Reports Opens the Reports window, where you can access all system reports
and configure the default report settings.

3.1.1 .2 Est imate tab

The following image and table show an overview of the Estimate tab:
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Name Description

1 Cost
Breakdown
Structure
(CBS)

Opens the Library Cost Break Structure register, where you can define
the CBS that will automatically import when a new project is created.

2 Account
Code
Utilization

Used to roll estimate line items into an account code hierarchy and
benchmark against historical projects in a way that is consistent across
projects.

3 Work
Breakdown
Structures

Opens the Library Work Breakdown Structure register, where you can
define additional Work Breakdown Structures that will automatically
import when a new project is created.

4 Master
Workbook

Opens the master Microsoft Excel template which will be embed into
each new estimate job folder. The cells in the embed excel workbook
can be linked to send information to or from InEight Estimate Fields.

5 Indirect Cost
Items

Takes you to the Library Cost Breakdown Structure Register where you
can edit and define indirect cost items.

6 Job
Finance

Takes you to the Library Cost Breakdown Structure Register where you
can edit the Job Financing cost item.

7 Price % Add
On

Takes you to the Price % Add On record, where you can define the price
% add to be included in the Library CBS.

8 Prime Bond Opens to the Library Prime Bond record where you can define the bond
tables that will import automatically when a new project is created.  

9 Reports Opens the Reports window, where you can access all system reports
and configure their report settings.

InEight Inc. |  Release 26.5 Page 91 of 419

Estimate User Guide 3.1 Library overview



3.1.1 .3 System tab

The following image and table show an overview of the System tab:

Name Description

1 Customize Opens the Customize settings page to customize the field titles
that are shown throughout various pages in Estimate, including
all cost category titles, user-defined tags, and more.

2 Saved Views Allows you to save your views onto a disk or load from a disk.  

3 Titles Allows you to save titles onto a disk or load from a disk.  

4 Colors Allows you to save your colors onto a disk or load from a disk.

5 Output
Settings

Allows you to save your output settings onto a disk or load from
a disk.

6 Quantity Item
Settings

Save your mapped quantity item source settings to your
computer. You can then load the saved mapped settings into
your Quantity Item Sources Register.

7 External
Reports

Menu to not only generate reports created by Estimate, but also
to open programs, folders, documents, reports, or Internet
resources with the associated program.

8 External
References

Allows you to open programs, folders, documents, reports, or
Internet resources with the associated program.

9 Help Section Offers you links to Estimate’s general Help menu, information
about Estimate (i.e., version number, system information, tech
support, etc.), What’s New in the new version, and InEight’s
external website.
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Externa l repor ts

The External Reports menu lets you generate reports created by Estimate, and also lets you open
program files, folders, documents, or other internet resources.

Each menu item can be added to the External Reports menu. Upon selecting one of the menu items,
the associated program, file, folder document or URL will open, as defined by the command entered in
the Open column.
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To add a new menu text, first select the Add button and enter a name in theMenu Text field, and then
type in the location of the new Menu text under the Open field.
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Customized Job Folder Tags match the view of the fields in the Job Properties form.
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3.1.1 .4 In tegrat ions

The following image and table show an overview of the Integrations tab:
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Name Description

1 Publish Estimate to a
New Project

Lets you publish an estimate job to a new project.
This requires the installation of the data provider plug-
in.

2 Publish Cost Items to
Active Project

Lets you publish cost items to an active project. This
requires the installation of the data provider plug-in.

3 Publish Cost Items for
Change Management

Lets you publish cost items to InEight Change. This
requires the installation of the data provider plug-in.

4 App Logs Lets you open the Estimate application logs in Project
Suite, view log details, and export to Excel.

App logs

The InEight Project Suite App Log lets you drill down to the Detail level which helps you find, analyze
and solve application errors.
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3 . 2 L IBRARY JOB PROPERT IES

The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and
settings you fill out will be automatically imported into a new job. Once imported, these settings can
be changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

l Overview Tab Notes Field:  Filling out the Notes section at the Library level would be helpful for
any instructions or reminders that you want to display on all projects’ Job Properties form. For
example, “Always double check currency exchange rates”

l Cost Basis Tab:  Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

l Fuel Cost Tab:  Entering a default fuel cost here will factor with the utilization of your equipment
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to be included in your equipment rates

3 . 3 L IBRARY ADDRESS BOOK

Estimate's vendor and contact information in the address book register integrate with InEight
Platform's vendor and contact master data libraries.

Vendors and contacts are created and maintained in Platform's master data library as a single source
repository of vendor and contact data.
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The vendor and contact data structure shows a new hierarchy where multiple contacts can be assigned
to one vendor.

3.3.1 Pre-existing Estimate data

Upon upgrading to version 23.6, address book records show a combined list of both pre-existing
Estimate Address Book records and Platform vendors and contacts. Pre-existing Estimate Address Book
records are still editable, but Platform records are not. The pre-existing disconnected vendors and
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contacts show a red glyph to the left of the Vendor ID column which shows that these records are
disconnected from Platform.

The existing contact records also have a vendor record associated with it. New vendors and contacts
must be added via Platform, and changes to any Platform originated records must be modified in
Platform. This promotes the use of Platform as the single source of creation and maintenance for
vendor master data.

3.3.2 Estimate specific data

Certain vendor affiliated qualification information required for estimating purposes such as licensed,
bonded and insured data, or minority participation, is maintained directly in Estimate only rather than
in Platform.

There can be other Estimate vendor and contact data that only exist in Estimate and not in Platform,
such as License, Bond, Insurance and Minority Certifications, and Default Quotes.
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3.3.3 Address Book layouts

You can choose between three address book page arrangements, vendors and contacts, vendors and
default quotes, and contacts.

3.3.3 .1 Vendors and Contacts

Vendors and Contacts are arranged where the vendor is the primary record in the register, and the
contacts associated with the vendor are shown as secondary detail records.
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3.3.3 .2 Vendors and Defau l t Quotes

Vendors and default quotes are arranged where the vendor is the primary record in the register, and
the default quote group assignments for the vendor are shown as secondary detail records.
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3.3.3 .3 Contacts

Contacts are arranged where the contacts are shown in a flat list and are not secondary detail records
under the Vendor. This layout can be used to search more easily for contacts regardless of their vendor
assignment.

3.3.4 View vendors and contacts in InEight Platform

Select View Vendors or View Contacts to open a new InEight Platform master data vendors and
contacts browser.
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To view or edit a vendor, click the Vendor ID. The Platform Edit vendor > Vendor Details page opens.

3.3.5 Vendor and contact creation

You can quickly create ad hoc vendors and contacts via the Quote Register and Record forms.

After you receive vendor quotes and you are ready to enter quote information, it can be an optimal
moment to create new vendors and contacts if they are not currently in the Address Book. Creating
vendors and contacts on the fly while the vendor quote information is readily available, and then
entering the quote information is more expedient than leaving the quote to create the vendor and
contact in Platform. This is especially useful when you have multiple new vendor quotes.

You can create vendors and contacts on the fly in both the Quote Register > Address Book Register
Library and directly from the Quote record.
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For example, when you are in a quote record and need to quickly create a new vendor because the
vendor you received a quote from does not yet exist, you can select the Vendor Quick Add button, and
then enter in the vendor details in the Vendor Record – Library form.
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You can also add additional qualification information in the License/Bond/Insurance and Minority
Certifications tabs.
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The additional qualification information is added and maintained in Estimate and cannot be
added to the vendor record when creating vendors directly in Platform.

After the vendor is created, it is included in the Library Address Book and can be chosen as a vendor to
be used on a quote.
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If you have a new contact to add, you can select the Contact Quick Add button, and then enter the
contact information.

After the contact is created, it becomes associated with the newly created vendor in the Library
Address Book.
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The vendor and contact information are stored in Platform where it can be easily accessed by selecting
one of the vendor ID links in the Library Address Book. The vendor can also be used by other Platform
applications.
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3.3.6 Merge and upload contacts and vendors into Platform

You can manage and retain all vendor information in the Estimate Address Book that are not linked
(disconnected) with Platform, including contacts and companies that are referenced in multiple
estimates, quotes and RFQs.

Disconnected Vendors and Contacts can be merged with existing Platform vendors and contacts, or
they can be uploaded to create new Platform vendors and contacts by navigating to the Library > Setup
> Address Book. You can also upload new Estimate vendors and contacts into Platform's master data
repository.

Estimate's process of uploading contacts and vendors into Platform's master data library (as a means
for all InEight products to access as a source system of contact and vendor data) not only lets you send
this information to Platform, but it provides you with a mechanism to clean up and simplify existing
Estimate Address Book data. For example, your current Estimate Address Book might contain many
duplicate contacts containing the same first and last name, but with different addresses, emails, or
mobile numbers. Merging these records helps administer customer data better so that you can
eventually only maintain a single contact or vendor that has the most up to date and most accurate
information.

3.3.6 .4 Disconnected contacts and vendors

Pre-existing Estimate vendors and contacts that are disconnected from Platform show a red glyph to
the left of the Vendor ID column, and only exist in Estimate at this time. To only show the disconnected
records, click the column filter in the Vendor ID column, and then select (Blanks). You can either delete
the disconnected records or choose to merge or upload them into Platform.

Showing only the disconnected vendors or contacts helps you see the vendors and contacts that are
not connected with Platform.
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All new library address book records must be created in Platform.

Vendor and contact ID's that show a blank do not currently have an associated Platform vendor
association, as these vendors were originally created in Estimate. These vendors have not been merged
into Platform, and therefore have no association with the vendor master data that resides in Platform.

Inact ive contacts and vendors

You can mark a vendor as Do Not Use in a contact record, which indicates the status of the contacts
associated vendor, and can only be set in Estimate when vendors are disconnected from Platform. The
record changes to red to signify it is inactive and cannot be used, but is not deleted from the system.
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To change the Do Not Use status, select the Vendor ID Platform link for the vendor record in Estimate.
In Platform, the Do Not Use flag can be maintained by selecting the Status field in Master Data Libraries
> Vendors, and automatically integrates with Estimate.
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Merge Estimate vendors to Platform

1. Choose one connected and disconnected vendor, then selectMerge Vendors with Platform.

l Note that the connected Estimate vendor previously exists in Platform, prior to the
merge of the two vendor records.

2. SelectMerge.

l Notice that the primary vendor is checked, as this record already exists in Platform.
l Other records where the Primary field is not checked are records to be merged into
the primary record.

l Fields in yellow for the non-primary records are deltas. These deltas will not be
merged, and differences will be lost once they are merged, as the data that exists in
Platform takes precedence. If you want any of the disconnected data to exist in
Platform, you need to manually change the data in Platform. The advantage for this
is to allow for the disconnected Estimate vendors to become associated with an
already existing Platform vendor, which lets the contact to still be keyed in areas it
was used in Estimate, such as in Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.
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Upload Estimate vendors to Platform

1. Choose a disconnected vendor with an associated contact, and then select Upload Vendors to
Platform.

2. Click the + symbol to the left of the Vendor ID to expand all the records. Select Upload to sync
the vendor shown with the contact in this window to Platform.

l The preview dialog box opens.

3. Select Yes in the Attention dialogue box to confirm that the vendor will be uploaded to Platform
and synchronized back to the Estimate Address Book library.
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Merge contacts to Platform

1. Choose one connected and one disconnected contact, and then selectMerge Contacts with
Platform.

l Prior to the merge, note that the connected Estimate contact previously exists in Platform,
prior to the merge of the two contact records.

2. SelectMerge.
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l Notice that the primary contact is checked, as this record already exists in Platform.

l Other records where the Primary field is not checked are records to merge into the
primary record.

l Fields in yellow for the non-primary records are deltas. These deltas will not be merged,
and differences will be lost after they are merged, as the data that exists in Platform takes
precedence. If you want any of the disconnected data to exist in Platform, you need to
manually change the data in Platform. The advantage for this is to allow for the
disconnected Estimate contact to become associated with an already existing Platform
contact, which lets the contact to still be keyed in areas it was used in Estimate, such as in
Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.

l A message shows it was successful, and the entry is created in Platform.
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Upload contacts to Platform

1. Choose a disconnected contact, and then select Upload Contacts to Platform.

2. Select Upload to send the contact shown in this window to Platform.

l The purpose of the preview dialog is to let you see what will be created in Platform, and to
correct any issues before completing the operation.

3. Select Yes in the Attention dialogue box to upload the contact to Platform, synchronize back to
Estimate, and save to the library.
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l A message shows it was successful, and the entry is created in Platform.
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Create vendors and contacts via Quote Record

1. Navigate to the Quote register and open an existing quote.

2. Click the Vendor Quick Add icon in the Quote Record register.

3. In the Vendor Record - Library window, enter a new Vendor ID and Vendor Name. Under the
Vendor Name field, enter in the other non-required information such as the Address and Phone
Number.
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4. On the right side of the window, enter any relevant information in the tabs, such as vendor
notes and license, bond and insurance information, and then click OK.

The new vendor is now added to the Estimate Address Book Register - Library.
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The following steps help to confirm that the vendor was created correctly, and that it can
be used to update or maintain the vendor after it has already been created, including steps
to create a new contact on the fly.
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5. Click the new Vendor ID in the Estimate Address Book Register - Library.

The new vendor opens in Project Suite > Master data libraries > Vendors.
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6. Click the Contact Quick Add icon in the Quote Record register.

7. In the Contact Record - Library window, enter the First Name, Last Name, Company, and
Primary Email. Under the Primary Email field, enter in the other non-required information such
as the Address and Phone Number, and then click OK.
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The new contact is now added to the Estimate Address Book Register - Library.
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8. Click the new contact Vendor ID in the Estimate Address Book Register - Library.

The vendor opens in Project Suite > Master data libraries > Vendors, and includes the new
contact.

Page 126 of 419 InEight Inc. |  Release 26.5

3.3 Library address book Estimate User Guide



3 . 4 L IBRARY JOB PROPERT IES PR IC ING

3.4.1 Job Properties overview

In Job Properties Overview > Pricing, there are balanced price and markup options in the bid pricing
area which lets you categorize costs, markup various costs in an estimate, and distribute that markup
throughout the bid which establishes balanced bid prices.

3.4.2 Balanced Price Options

This option determines if a pay item will use the cost or billing amount values of the assigned cost
items as the basis for determining a balanced bid price. This also determines if the AutoPrice command
will use the cost or billing amount values.
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3.4.2 .1 Calcu la te Balanced Pay I tem Pr ices us ing Cost Amount :

3 .4 .2 .2 Calcu la te Balanced Pay I tem Pr ices us ing Bi l l ing Amount :

Page 128 of 419 InEight Inc. |  Release 26.5

3.4 Library Job Properties Pricing Estimate User Guide



3.4.2 .3 Dis t r ibut ion of Unass igned Costs /B i l l ing Amount by
Ind iv idua l Categor ies

Any costs in the estimate not assigned to a pay item needs to be proportionally spread back to all pay
items to determine a balanced bid price. This option lets the user choose the basis for calculating the
weighted distribution of any unassigned costs plus markup.

l Individual Categories - this option uses each individual cost categories as the basis for
establishing the weighted distribution amounts.
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l Top Level Cost Categories - This option uses the ten top level cost categories (labor, owned
equipment, rented equipment, supplies, materials, etc.) as the basis for establishing the
weighted distribution amounts.

l Total Cost[/Billing Amount] - This option uses Total Cost as the basis for establishing the
weighted distribution amounts.
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3.4.2 .4 Markup Opt ions

This option determines how markup is applied to pay items when establishing a balanced bid price.

l Using Weighted Distribution. Marking up Pay Items using weighted distribution takes the total
markup and proportionally spreads the amount using the chosen weighted distribution method.

l Keeping Markup rates to Assigned Costs. This option uses the cost category amounts of all
assigned cost items and calculates the markup by applying markup percentages as defined in the
direct and indirect cost markup records. Excluding cost items from the dependency tab of the
markup record precludes the application of that markup percentage to the assigned costs on
that pay item.
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3.4.2 .5 Categor ize Bus iness Overhead as Ind i rec t Cost

This option controls where cost Items with a cost segment of business overhead appear in the PBS.

l Indirect Cost - Business Overhead is included as a subcategory of indirect costs in the PBS.

Page 132 of 419 InEight Inc. |  Release 26.5

3.4 Library Job Properties Pricing Estimate User Guide



l Markup - Business Overhead is included as a subcategory of Markup in the PBS.

3.4.2 .6 Calcu la te Proposal Recap Forecast Markup

This option determines how the Markup is determined in the Forecast column of the Proposal Recap
data block on the Pay Item & Proposal form.

l Unit Markup (current) × Forecast (T/O) Quantity - The Forecast Markup amount is determined
as the sum of each Pay Items Unit Markup (current) multiplied by the Pay Items Forecast (T/O)
Quantity.
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l Forecast Price Total Price - Total Cost/Billing. The markup amount is determined by subtracting
the sum of the total jobs cost based on forecast (T/O) quantities from the forecast bid price,
which is the sum of all pay item current unit prices multiplied by the pay items forecast (T/O
quantity).
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Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

You should be aware of the category labels on the following table:

Category Labels

Name Definition

Account
Codes

These codes will be set up on the back end and will help you compare your
cost and production rates to similar cost items in past projects.

Tags Some tags are already set up for you. Additional tags can be created and used
to group and filter your items.

Work
Breakdown
Structures

Use this format when you need to have multiple variations and summary
reports of an estimate. WBS retains the same relationships between items as
in the original estimate and only changes the view and how items are
arranged in hierarchy.

Units of
Measure

These are standardized to relate to one another by a conversion factor. If you
need to create a new unit of measure, you will need to reference it to a base
unit of measure and can include a conversion factor to allow you to convert
back and forth between English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange
rate for other currencies (such as Canadian) so you can estimate with
whatever currency you need. Multiple currencies can be used in the same
project. The system base currency can be changed from USD in the
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Category Labels

backstage view settings, but is a global change for the entire estimate
environment.

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.

3.4.3 Quote group tags user defined fields

You can use three user defined fields (UDF) in the Quote Groups tag register to enter certain key
information such as responsible party or certain other attributes for better visibility. If preferred, these
UDF fields can be viewed in Quote Compare and Award forms and Session Recap register.

3 . 5 RESOURCES
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3 . 6 RESOURCES OVERV IEW

InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:

Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is
typically classified by trade (e.g., pipefitters, electricians, iron workers) and
title (e.g., foreman, journeyman, laborer).

Construction
Equipment

Owned construction equipment.

Rented
Construction
Equipment

Construction equipment rented from a third party.

Installed
Material

Materials that will remain installed on site after the project is completed, (e.g.,
concrete, piping, aggregate).

Installed
Equipment

Equipment that will remain installed on site after the project is completed,
(e.g., boilers, heat exchangers, vessels, cooling towers).

Supplies Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types
(e.g., dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the new
project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.
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3 . 7 L IBRARY RESOURCE RATE REG ISTER

To open the Library Resources Register, click the Resources icon in the Master Resources ribbon.
Alternatively, you can click the Labor, Equipment, orMaterials icons to navigate directly to those tabs
in the register.

Name Description

1 Tabs There are tabs along the top of the form for each of the seven resource
types, in addition to an All tab that holds the resources of all types.

l Notice that you are on the Labor Tab

2 Resource
Code

Each record (or row in the register) represents a single resource.

3 Description The Description provides more detail about the resource.

4 Resource
Rate per
Unit

This is the resource cost per unit.

5 Utilization
Count

Tells you how many units of that resource are being used in the job.

6 Unit of
Measure

Each resource is defined with a Unit of Measure.

7 Register This register includes columns for the resource attribute categories so you
can filter and group your resources.
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Source Job and Source System name f ie lds

The Source Job field provides visibility into the jobs from which the data may have originated from.

The Source System Name helps to see the source of the data when integrating with other systems.

You cannot add new resources on the All tab. You can search for resources in the Resource Rate
Register using the Find field.

3 . 8 RESOURCE RATE RECORD

If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click the row header
for the resource you need to view in greater detail.
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Name Description

1 Record The record references the resource you are editing.

2 Charge Rate The Charge Rate tab is the tab the record defaults to and is where you
define the cost of the resource.

3 Scale
Buttons

The Scale buttons only show up on labor resources. They are used for
defining regular time, overtime and double time rates for the resource.

4 Cost
Category
Breakdown

The Cost Category Breakdown is where you enter the costs for the
resource. The categories will depend on what type of resource it is (e.g.,
equipment resources will have equipment cost categories and materials
will have material cost categories).

5 Special
Instructions /
Base Wage
Factors

The right side of the record will have additional options to help you define
the rate. These options change depending on what type of resource it is.
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Name Description

6 Setup You can define the resource’s attributes, plus other settings. These attributes
are used for filtering which resource rates to load into a new estimate.

7 Cost
Driver

Labor resources default Cost Driver is CI Duration which means their costs
are driven by time.

8 Default
Quantity

The Default Quantity is typically set to 1 for most cases if you are bringing in
the resource you are using at least one.
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3.8.1 Use cost item's quantities

In the Setup tab, you can select to use the cost item's quantity as the default quantity for the following
resources:

l Installed material

l Installed equipment

l Supplies

l Unique

For more information, see Use cost item quantity option.

3 . 9 RESOURCES

Resources are used as the basic building blocks to detail costs in your estimates. You can manage the
following resources in the Resource Rate Register:

l Labor

l Construction Equipment

l Rented construction equipment

l Installed material
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l Installed equipment

l Supplies

l Unique

3.9.1 Labor resources

Labor resources perform direct or indirect work. Looking at your Labor resources more closely, you will
see all the Resource Codes for the Labor resources begin with an L. This is a best practice for naming
and organizing your resources, but you can also use another organizational method of your choice.

Create a labor resource

1. From the Library landing page, on the Setup tab, click the Resources button in the Master
Resources section. The Library Resource Rate Register opens

2. Select the Labor tab.

4. Right-click any row header and select New. A new Labor Rate Record shows.

5. In the Code field, type L + [your initials].

6. Press the Tab key.

7. Fill in the Description field.

8. Click on the resource’s Setup tab, and then select Standard Labor Rate File from the Resource
File drop-down list.

9. Select a location for the Geographic Area.

10. SelectWage Zone A for Wage Zone.

11. Select a labor type for the Organizational Category.

12. For Tag 1, select a code.

13. For Tag 2, select a code.
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13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and
Subsistence.

When you enter a value in the Amount column, the gray arrow Indicator icon points to the
amount side (left), indicating that the value is entered in that column. When the Percent column
amount shows Varies, it is because the percent amount varies depending on the amount
entered.

When you enter a value in the Percent column, the gray arrow Indicator icon points to the
percent side (right) indicating that the the value is entered in that column. When the Amount
column amount shows Varies, it is because the amount varies depending on the percent
entered.
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15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.

17. Click OK, to close the record.
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3.9.2 Construction equipment resources

Similar to Labor Resources, construction equipment resources are also duration driven resources by
default. Construction equipment resources contain cost categories for ownership and operation costs

These resources are the fleet of construction equipment that you own.

3.9.3 Rented construction equipment resources

Rented construction equipment resources represent the construction equipment that you rent and are
duration driven resources by default. They contain cost categories for rental and operation cost as well
as additional fees.

On the Rental Construction Equipment Record, you can view a tab named Quote. In the Tax section,
you can select the check box to Apply Standard Tax, which pulls the Sales Tax percentage defined on
the Cost Basis tab in Job Properties. You can also manually specify a unique sales tax rate
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Create a rented construction equipment resource

1. Open the Library Resource Rates Register.

2. Select the Rented Construction Equipment tab.

3. Right-click any row header, and then choose New. A new Installed Rented Equipment Rate
Record shows.

4. In the Code field, type RECR + [your initials], and then press Tab.

5. In the Description field, type Crane 110 Ton.

6. Click the resource’s Setup tab, and then select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

8. Click the Charge Rate tab, and then enter the charge rate using the relevant fields. You can also
use the Non-Hourly Period Charge Rates section on the bottom left to calculate hourly rates for
fixed rates such as weekly or monthly rates. See the Non-Hourly Rate Calculator section below.

3.9.3 .1 Equipment consumpt ion rates

The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that factor with the fuel cost you define on the Library Job Properties > Fuel Cost
tab to give a fuel cost for your equipment rate.

Page 148 of 419 InEight Inc. |  Release 26.5

3.9 Resources Estimate User Guide



The below figure shows where consumption rates are defined on the Construction Equipment
Resource Rate Record.

3.9.3 .2 Non-hour ly ra te ca lcu la tor

For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly
or monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource
Record to come up with the hourly rate.

Using the Non-hourly rate calculator

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates check box.

2. On the resulting prompt, click OK.

3. In the Period field, selectWeekly.

4. In the Amount Per Period field, type in a number value.

5. Type in a number of hours in the Hours Per Period field.
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6. Click OK to close the record.

3.9.4 Installed materials, installed equipment, and supplies
resources

When you compare the Installed Material & Equipment resources to those covered so far, you will
note that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
quantity-driven resource, as opposed to duration-driven like your labor and equipment resources.

You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record.

On record for these resource types, you notice a tab named Quote. This tab shows because you may
have to shop around and get quotes for these resources.
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In the Setup tab a field namedWaste % Add-on shows. Here you can account for approximate waste
percentages

Cost categories differ on each type of resource record.

Above is an example of the Installed Material tab in the Library Resource Rate Register.

Create an installed material resource

1. Select Resource Rates from the Library landing page. The Resource Rate Register displays

2. Select the Installed Material tab.

3. Right-click any row header, and then select New from the drop-down menu. A new Installed
Material Rate Record shows.

4. In the Code field, typeMGBP + [your initials], , and then press Tab.

5. In the Description field, type Brick Pavers.

6. Select a unit of measure from the Unit of Measure drop-down list.

7. On the resource’s Setup tab, under Resource File select Standard Material Rate File.

8. On the Charge Rate tab, expand Materials, and then enter a number value in the Installed
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Materials Amount field.

9. Click OK to finish adding this resource.

3.9.5 Unique resources

The Unique resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

The Unique resources are the only resources that have all cost categories available, as well as all units
of measure.

Notice the tax field which can pull your standard tax settings from the Cost Basis tab in Job Properties,
or a unique sales tax rate can be manually entered in each record.

3 . 10 USE COST ITEM QUANT ITY OPT ION

In the Resource Rate Register, you can select the Use Cost Item Quantity as Default Quantity option for
resource rate records. When you select resources in your estimate and the option is selected, the
resource rate record inherits the cost item quantity. This saves you time and helps prevent potential
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mistakes by eliminating the need to manually re-enter the resources quantity after employing
resources.

In the Use Cost Item Quantity as Default Quantity column, select the check box for the resource you
want to use the cost item quantity as the default quantity. This feature is available for the following
quantity based resources:

l Installed material

l Installed equipment

l Supplies

l Unique

Typically, in the Resource Rate Register, resource quantities are set to either zero or one and are
employed with those quantities. When the Use Cost Item Quantity as Default Quantity check box is
selected and you employ a resource with a quantity of one into a cost item with a quantity of 5,000
cubic yards, the newly employed resources inherit the cost item’s quantity of 5,000 cubic yards.

In the example below, the resource 2500 psi Mix is employed in cost item Concrete Materials. When
employed, the resource inherits the cost item’s quantity of 5,000 cubic yards.
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The cost item’s quantity is inherited for any employed resources when you employ the same
resource to multiple cost items or employ multiple resources at a time.

The Use Cost Item Quantity as Default Quantity option is also available to select when creating or
editing a resource rate record.
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3 . 11 RESOURCE ASSEMBL IES

A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew,
Concrete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly.
Utilizing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

3.11.1 Library resource assembly register

To open the Library Resource Assembly Register, select the Library icon, and then select Resource
Assemblies from the Master Resources section of the Setup tab. The Resource Assembly Register
opens.

The following image and table shows an overview of the library Resource Assembly Register.
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Section Description

1 Each row in the register represents a single resource assembly and is defined with
an Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus icon next to its Assembly
Code.

3 Expanding an assembly reveals the list of resources that make up that assembly.
l Best practice for creating Assembly codes is to use C for Crew Assemblies, M
for Material Assemblies, etc., however you can have labor, equipment, and
materials in the same assembly

3.11.2 Resource assembly record

To open an existing Resource Assembly Record, right-click on the row header of an assembly (row) on
the Resource Assembly Register, and then select Open.

The following image and table show an overview of the resource assembly record.

Name Description

1 Assembly
Code and
Description

Each assembly is defined with an assembly Code and an assembly
Description.

2 Quantity Each assembly has a quantity and unit of measure. The default is 1 EA.
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Name Description

and Unit of
Measure

For crew assemblies with all hourly duration driven resources, it is a best
practice to change the Qty to Hour, so that when used on a cost item, it
will show you the assembly’s unit cost per hour.

3 Assembly
Details

The rows in the Assembly Details register represent the resources that
make up the resource assembly.

4 Notes An area where the estimators make notes for records related to the
resource assemblies for work orders which is commonly performed by a
type of crew.

3.11.2 .1 Product iv i ty ra te ind icator in the CBS regis ter

The Productivity Indicator shows the field that contains the as-entered value and is driving the
estimate for that cost item. This appears as an arrow aligned to the left of the cell as shown below.

Being able to see productivity drivers on the CBS register makes it easier to review and modify the
estimate as a whole while reducing the potential to accidentally overwrite a manually entered data.

Follow the step by step below to create a Resource Assembly.

Create a resource assembly

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies. The Resource Assembly Register shows.

2. Right-click on any row header, and then select New from the drop-down menu. A new Resource
Assembly Record is shown.
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3. In the Code field, type a code as the unique code for the assembly. For example, you can type
CEXC + [your initials].

4. Add a description in the Description field.

5. In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that shows in the cell.

6. On the Labor tab of the resulting register, select the resource with your description. For
example, you can select LL2Laborer, and then click OK to add this resource to the assembly.

7. You can add dditional resources if needed.

You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.

Page 158 of 419 InEight Inc. |  Release 26.5

3.11 Resource assemblies Estimate User Guide



Exercise 3.1 — Create resources & resource assemblies

In this exercise, you will practice creating resources and assemblies in the InEight Estimate Library. In
the Library Resource Rate Register, create resources with the following variables:

Resource Code LSFA Wage Zone Wage Zone A

Resource
Description

Field
Administrator

Organizational
Category

Supervision

Geographic Area Southwest Scale 1 Labor Base $33.45

Scale 1 Premium 2 percent Scale 1 Subsistence $0.47

Resource File Standard Labor Rate File

Select the checkbox for Use Base Wage Factors for Scales 2 and 3.
Scale 2 Factor: 1.50 x Base Wage. Scale 3 Factor: 2.00 x Base Wage.

Labor Resource

Rented Construction Equipment Resource

Resource Code RPW3000 RE Rental Amount $3.40

Resource
Description

Pressure Washer 3000
PSI

Organizational
Category

Clean & Inspect

Resource File Standard Rental Rate File

Installed Material Resource

Resource Code MCCB Installed Materials Amount $300.00

Resource
Description

Pre-Cast Concrete
Catch Basin

Organizational Category Concrete

Resource File Standard Material Rate File

Unit of Measure Each

Uncheck the box for Apply Standard Tax and enter a Unique Sales Tax Rate: 6%

Rented Construction Equipment Resources
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In the Library Resource Assembly Rate Register, create resource
assemblies with the following codes, descriptions, and resources.

Assembly Code CBRIDGE

Assembly Description Bridge Crew

Resource File Standard Assembly File

Unit of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LC3 Carpenter Foreman 1

LL2 Laborer 2

LF2 Finisher 1

LC2 Carpenter Journeyman 2

Assembly #1

Assembly Code CRIPRAP

Assembly Description Rip Rap Replacement Crew

Resource File Standard Assembly File

Unite of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LT2 Teamster Foreman .5

LO3 Operator Class 3 1

LL2 Laborer 2

EX510 Backhoe JD 510 1

Assembly #2
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ETPU Pickup 1

EL950 Loader 950 1

Assembly #2 (continued)

You should end up with similar results:

Congratulations, you have completed this exercise!
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3 . 12 IMPORT ING RESOURCES

The following procedures inform you how to setup resources in InEight Estimate from an excel sheet.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the Sort, Group, Filter, Excel integration functionality in InEight Estimate is
required.

3.12.1 Open the Resource Rate Register

You can create resources within the Resource Rate Register. This is the location to build out the
structure of those resources.

Opening the Labor tab

1. Open the Job Folder or Library that you’re going to be working in.

2. From the Ribbon, select the Setup tab.

3. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

4. Select the tab you want to add resources to.

The layout of this register and excel file is up to the organization and the decisions that are made
during the detail design phase. A basic excel file will be provided to your organization as a starting
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point to work from. If that can’t be located, you can easily build one utilizing the views within InEight
Estimate.

3.12.1 .1 Creat ing a labor saved v iew - Resource Rate Regis ter

You can create a view to mirror both the register and excel sheets to easily bring information back and
forth from the two applications.

Example of columns:

l User Defined 1
l Resource Code
l Description
l Resource File Description - Validated field
l Geographic Area - Validated field
l Wage Zone - Validated field
l Organizational Category - Validated field
l Tag 1 - Validated field
l Tag 2 - Validated field
l Currency - Validated field
l Default Quantity
l Use Base Wage Factors - Scale Factors
l Scale Factor 2 - Scale Factors
l Scale Factor 3 - Scale Factors

For more information on Validated Tags field, see Validated Tags topic. Scale Factors aren’t
required if you are manually applying rates to each cost category scale.

The view should appear as shown below with User Defined 1 in the first column. This field is used for
sorting and arranging data accurately moving between Estimate and Excel. You are not limited to UDF
1 and can choose to utilize a field of their choice for sorting.
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3.12.2 Setting up the excel file

Go to the Excel sheet and make sure the information in the columns shown in the screenshot are filled
out. Basic concepts to keep in mind regarding the excel file:

Sort Code - This column needs to have a high sequential number such as 10000. This is very important
to assign as it will help us authenticate all the labor rates.

Resource Code - A unique Naming convention to be assigned to every labor resource. In this example
we have all labor resource starting with a L followed by the letters that represent the resource
description.

Labor Base - The base wage of the labor resource is entered here. Estimate does not allow $ sign to be
pasted, which is why the cells for the Base column are formatted to Number.

3.12.2 .2 Creat ing the resource

Follow this procedure once you have information filled out in excel.
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Creating the resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Labor tab of the Resource Rate Register.

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

8. Select Yes to confirm inserting the selected values.
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9. The cells you copied from the excel sheet are now copied into the Resource Rate Register. The
Sort code data is pasted in the User defined 1 column. Resource Code & Resource description
data is pasted as well.

10.
For Make sure the sorting is on User Defined 1 column. This allows us to see the
information being sorted similar to our data in excel file. Base Wage Factors need to be
flagged to turn on with the check box. Your first copy and paste should have activated
them. You need to copy and paste again in order to apply the factors.
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3.12.2 .3 Resource cost deta i ls

Labor resources are now in the system a user can apply rates to those resources.

Resource cost detail

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3.
Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Labor view to filter down to only labor resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.
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Example of columns – The level of detail and utilization of specific cost categories is a decision for each
organization:

l User Defined 1 - Non editable fields from resource rates register
l Resource Code - Non editable fields from resource rates register
l Description - Non editable fields from resource rates register
l Resource File Description - Non editable fields from resource rates register
l Geographic Area - Non editable fields from resource rates register
l Wage Zone - Non editable fields from resource rates register
l Organizational Category - Non editable fields from resource rates register
l Scale - Non editable fields from resource rates register
l Labor Base
l Travel
l Premium
l Holiday
l Savings
l Pension
l Vacation
l Subsistence
l Health & Welfare
l Apprenticeship
l Undefined Fringe 1
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l Undefined Fringe 2
l Undefined Labor Fringes
l Bodily Injury & Property Damage
l Workers Compensation
l Undefined Insurance1
l Undefined Insurance2
l Undefined Labor Insurance
l FICA
l FUTA
l SUTA
l Undefined Tax1
l Undefined Labor Taxes
l Undefined Labor Burden
l Undefined Labor
l Construction Supplies
l Undefined Materials
l Undefined
l Billing Rate
l Billing Rate Markup
l Billing Rate Markup %

3.12.3 Filter/Sort/Paste - Resource Cost Details Register

The Labor upload view brings in the columns required to enter Labor base, burdens etc. Every Labor
resource has three rows created with Scales 1,2,3. The Scale Column is used to setup Straight time,
Over time, Double time.
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Step by Step — Filter Resource Cost Detail Register

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 1.

3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.
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5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values?message as before.
Select Yes to continue.

3.12.4 Manual set up of scales 2 & 3 – Optional

If the organization wants to have more in-depth cost details for each scale rather than using scale
factors the same procedure will be utilized to copy Labor burden, fringes, and other add-ons to setup
Scale 2 & Scale 3.

For Base Wage Factor Columns will not be active if your organization is using method 2.
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3.12.4 .4 Resource Rate Regis ter

3 .12.4 .5 Resource Cost Deta i ls Regis ter

Manual setup of scales

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 2.
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3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.

5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values?message as before.
Select Yes to continue.

7. Follow the same procedure for scale 3.

3.12.4 .6 Non labor resource setup

The same principles can be applied for the other resource types within InEight Estimate. This
procedure covers installed material, but can also be used for the other six resource types.

3.12.5 Creating a materials saved view - Resource Rate Register

Create a view to mirror both the register and excel sheets to easily bring information back and forth
from the two applications.

Example of columns
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l User Defined 1
l Resource Code
l Description
l Resource File Description - Validated Tag field
l Geographic Area - Validated Tag field
l Wage Zone - Validated Tag field
l Organizational Category - Validated Tag field
l Tag 1 - Validated Tag field
l Tag 2 - Validated Tag field
l Currency - Validated Tag field
l Apply Standard Tax - Validated Tag field
l Unique Sales Tax
l Unit of Measure - Validated Tag field

3.12.6 Creating a material resource

Follow the step by step once you have information filled out in excel.

Creating the resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.
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5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Installed Material tab of the Resource Rate Register.

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?
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8. You will be prompted with a Are you sure you want to insert these values?message. Click Yes
to continue.

3.12.7 Create a material saved view - Resource Cost Details
Register

Installed Material Resources are now in the system. You can apply rates to those resources. Create a
view to mirror the accompanying excel sheet or create one to bring in the associated resource cost in
the details register.

Material saved view

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3.
Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Installed material view to filter down to only
material resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.
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Example of columns – The level of detail and utilization of specific cost categories is a decision for each
organization:

l User Defined 1 - Non editable fields from resource rates register
l Resource Code - Non editable fields from resource rates register
l Description - Non editable fields from resource rates register
l Resource File Description - Non editable fields from resource rates register
l Geographic Area - Non editable fields from resource rates register
l Wage Zone - Non editable fields from resource rates register
l Organizational Category - Non editable fields from resource rates register
l Unit of Measure - Non editable fields from resource rates register
l Currency - Non editable fields from resource rates register
l Total - Non editable fields from resource rates register
l Installed Materials
l Undefined Materials
l Sales Taxes
l Undefined Fees
l Undefined
l Billing Rate
l Billing Rate Markup
l Billing Rate Markup %
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3 . 13 QUANT ITY CHECK ING

The Quantity Checking feature allows you to compare the quantity of a superior cost item to the sum
of its relevant subordinate cost item quantities. This setting enables the use of the Quantity Check and
Quantity Warning columns in the Cost Breakdown Structure. The use of these columns can assist in
confirming whether or not your quantities are correct.

The subordinate cost item quantities need to have the same unit of measure as the superior
cost item before you are able to choose the Quantity Check column.

In the example below, break a concrete pour cost item into four subordinate parts. The Forecast (T/O)
Quantity of the superior item will be 156875.00 tons of concrete. Start by dividing each of the four
parts into 35000.00 tons each. Once you have broken out this concrete pour, determine if you need a
fifth pour or if you should distribute the remaining quantity to the four pours. The factors you keep in
mind are the trips and time involved in the extra pour vs capacity of equipment.

Quantity checking

1. From the Ribbon, select the Setup tab.

2. Under the section Initialize, select Job Properties. Then select the Cost Basis tab.

Quantity checking starts by turning the feature on in the Job Properties. If you want to
have quantity checking turned on for all jobs in Estimate, then this setting needs to be
turned on in theMaster Job Properties. The Master Job Properties is located in the
Library.

3. From the Rules data box, select the Activate Quantity Checking check box.
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4. Next bring a couple of columns into your view on the Cost Breakdown Structure (CBS) Register.
Right click on the column header and choose Go To Column.

5. The Go To Column dialog box appears. Have the Include columns that are not currently in the
view check box selected.

6. Click OK when you have selected your preferred columns.

Next, toggle the check box for the Quantity Check column.
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7.
As you check Quantity Check for the four batches of Concrete, the superior cost item
Quantity Warning turns yellow. This is indicating a quantity warning. Hover your mouse
over the superior cost item Quantity Warning column. Then, an overlay message appears
showing the quantity discrepancy. Apply this discrepancy to the Subordinate cost items.
That way, the superior cost item with be the sum of the parts.

8. The remaining quantity is 16875.00 tons which does not warrant a fifth pour.

3 . 14 SECUR ITY IN EST IMATE

3.14.1 Role based permissions

Estimate uses a role-based security model, where users can be assigned to a role on a project or also a
role in a node of the organization breakdown structure (OBS). A role identifies if a user has been
granted access for various permissions to perform defined functions in Estimate. An advantage of using
role-based permissions to manage security is that it is possible for users to have different roles on
different projects where the role assigned to a user determines what they have permission to do
within any given project.

A role is a collection of permissions that defines a user’s responsibilities on a project or in an
organization.
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As an example of using role-based permissions to have different roles on different projects, a Lead
Estimators of the Utilities Division that gives them access to all estimates in that division, they are also
the Superintendent on one of the company's Mining projects, which gives them access to that projects
control budget and other applications used in project execution.

The role-based permissions for a project can be inherited from the OBS where the project is assigned.
You can be assigned a role in a node of the OBS, giving you the permissions granted by that role for
every project in that node of the OBS. This lets users have different roles on different projects,
meaning that what a user has access to do in any specific estimate is based on the role they have been
assigned for that project.

For example, in the following image, the user is the Lead Estimator of the Utilities Division.

Roles are created and managed in the Roles and Permissions page in InEight Platform Suite
Administration > Roles and permissions.
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The following image shows the Platform permissions available for Estimate in the Master data libraries
section.
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For more information on setting up roles in InEight Platform, see Roles & Permissions.

3.14.2 Security in Estimate

The capacity to grant permissions in a job and what can be performed is accomplished with a
combination of permissions that exist in both Platform and Estimate.

Generally, permissions managed in Platform determine which users can launch Estimate, manage the
Estimate library, and manage job templates. Permissions managed in Estimate determine which users
are granted permissions to specific commands and destinations solely in Estimate.

To use Estimate, you must have a role that includes the Edit estimate library or Use templates
permission.
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3.14.3 Granting permissions to access jobs and snapshots

When creating jobs in Estimate, it is required to associate new estimates with existing Platform
projects and all the related OBS contents.

Multiple estimates can be assigned to a single Platform project. In this case, permissions granted
to users on a project will be the same permissions for all the estimates belonging to that project.

This Platform project is used to assign roles for the purposes of granting various permissions.

To grant permissions to a particular user on a Job, go to the User Management page in InEight
Platform, edit the user, and then assign the user a role on a project on the Roles tab of the Add or Edit
User slide-out panel.
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For more information on managing users, see the User Management section in Roles & Permissions.

3.14.3 .1 Organizat iona l Breakdown Structure

Projects in Platform are required to have an Organizational Breakdown Structure (OBS) assignment.
The OBS assignments can be utilized for assigning roles and granting permissions to all jobs belonging
to a node in the OBS.

In the following example, Johny has been assigned as the Lead Estimator for the Site Work node of the
OBS, which grants him the permissions assigned to the Lead Estimator role for every estimate created
that belongs to the Site Work node in the OBS.
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Permissions are cumulative, so if a user is assigned multiple roles on a single project, the role
with the most permissions is applied when attempting to access various functions.

3.14.4 Granting permissions to destinations and commands

Estimate can grant permissions at a deep-rooted level by assigning which roles can access specific
forms. You can also assign certain roles that can perform specific commands or actions that can be
performed within those forms.
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Permissions are managed in the Access Control Register in the Setup tab of the Library.

This register is a list of accessible objects, which can be used to grant or restrict permissions to various
roles. By default, the register is organized by type, then by category. Removing the grouping lets you
search for key words using the search capabilities of the register.

InEight Inc. |  Release 26.5 Page 187 of 419

Estimate User Guide 3.14 Security in Estimate



The Type of the accessible object is one of the following:
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l Command: Actions that are in the main ribbon navigation.

l Destination: A form or location within the application. Restricting this type of permission means
that all the actions that are available in the form are unavailable.
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l Register Command: These are the commands that appear for the specified register and are
commonly accessed either by using the Actions menu in the navigation ribbon when the register
is active or using the right-click context menu commands on the records in a register.
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Categories and subcategories can be used to further group and identify various accessible objects.

The Ribbon Name column provides the navigation path and name of the object as it appears in the
ribbon navigation.

The Show Classic Navigation Accessible Objects button on the Actions tab of the Access Control
register can be used to identify accessible objects as they might have existed in the legacy version of
Estimate, and are still available to assist users who may have set up Access Control prior to the newer
ribbon navigation.

InEight Inc. |  Release 26.5 Page 191 of 419

Estimate User Guide 3.14 Security in Estimate



If no roles are assigned to an accessible object, no restrictions are applied to the accessible
object, and anyone with access to the application is able to access that destination or command.

When setting up Access Control, be sure to identify the commands and destinations in Estimate that
you want to restrict permissions to, and then assign the roles to explicitly grant permissions to those
accessible objects.

Limit access control on an accessible object

1. From the Library > Setup tab, open both the User Roles Register and the Access Control
Registers.

2. Drag one of the registers to the side of the other, so both are side-by-side.

3. Identify the role or roles in the User Roles register that only provides access to the Command,
Destination or Register, then right-click to copy.
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4. Select one or more accessible objects in the Access Control register, and then right-click to paste.

5. Expand the detail records of the accessible objects to verify the role assignments have been
correctly made.

Alternatively, you can drag and drop the Roles onto the accessible objects in these two registers.

InEight Inc. |  Release 26.5 Page 193 of 419

Estimate User Guide 3.14 Security in Estimate



In the following example, both Estimators and Lead Estimators are permitted to invoke any of the
actions on the records in the PBS Changes Register, but only the Lead Estimator is permitted to
activate or deactivate the PBS Changes Log. Because no roles have been assigned to the Activate View
Change Record prompt, anyone with access to the application will be able to perform that action.

3.14.4 .2 Access Cont ro l repor t

You can use the Access Control report to audit user permissions, command access, and various
restrictions without having to search through the Access Control register for this information.
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The report makes it easier to find the role names along with their associated Yes and No access
permissions to each form in Estimate.

Navigate to Control report

1. Open a job, and then select the Setup tab.

2. Click the Reports icon.

You can access the Reports menu from the Setup, Estimate, Quote, and Price tabs.
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3. Expand Library Module, and then select Access Control (Excel).

4. Select a file name, or choose another file name path.

5. Click Save, and then click Run.
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In the report, you can filter, sort, or perform any type of audit to help you determine user or role
access.

3.14.5 Granting permissions to the Estimate Library

In Platform, permissions relating to the Estimate library are found in the Master data libraries
permission section.
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To grant Estimate library permissions to a role, the role must be an Administrator Level 3 - Account
Admin. If not, the permissions are not selectable on the Add/Edit Role setup page.
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The Master data libraries permission section is also where the permissions controlling which roles can
manage templates are found.

3.14.6 Common roles used when securing an Estimate

The process of creating an estimate for a bidding opportunity commonly requires unrestricted access
to the capabilities of Estimate so that estimators can work efficiently. However, depending on the level
of data governance within an organization, you might want to preclude certain users from accessing
some of the more sensitive parts of Estimate. If changes were made, either accidentally or otherwise, it
could impose detrimental impacts on the organization.

Estimate’s security model is very detailed and robust. When designing a security model that restricts
certain features and functionality of Estimate, each company must weigh the benefit of the protection
of such restrictions which could bring unwanted or uncontrolled changes and negatively impact the
productivity of the estimating process. While it is possible to create a very detailed and robust security
model with many different roles for individuals within an organization, it is not necessary to set up and
maintain roles for all of Estimates accessible objects. It is likely a company can effectively secure their
sensitive data with no more than a couple roles granting permissions to a few commands and
destinations.

A common way to implement security on the Estimate application is to restrict access to certain
system level settings, such as who can modify data in the library, or who can change any company
specified custom column captions.

The following are some of the more common Roles a company may set up, describing the purpose of
the role and typical permissions:

l Lead Estimator: Lead Estimators are commonly assigned to estimates based on their knowledge
and experience. They may be precluded from creating or deleting estimates themselves or
changing any system level settings, but commonly have full access to all the capabilities needed
to create and maintain the estimates they are assigned to.

l Estimate Manager: Estimate Managers are commonly responsible for identifying bidding
opportunities and determining which opportunities to pursue. Once it has been determined that
the company will pursue an opportunity, the Estimate Manager creates the estimate and assign
it to a Lead Estimator based on resource availability relative to all the bidding opportunities the
company will be pursuing. These roles manage the creation of estimates and assist in ensuring all
the necessary supporting data is available, such as assigning appropriate project attributes or
including needed resource libraries.

l Administrator: Administrators ensure accessibility and availability of the solutions utilized by
estimators. Typically, they control system level settings and activities that would affect company
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standards, such as changing column captions, ability to define corporate views, list of job
statuses and ribbon settings. Other typical permissions restricted to only the Administrator level
roles are the ability to access the User Roles register and the Access Control register.
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Lesson 3 - Review

1. When you create a new job folder, all category labels defined in the Library Foundation Setup
Data Register will be copied to the new job folder automatically.

a. True

b. False

2. This resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

a. Installed Materials

b. Unique

c. Labor

d. Construction Equipment

3. The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define where?

a. Library Foundation Setup Data

b. Library Resource Rates

c. Job Properties

d. Cost Breakdown Structure

Lesson 3 - Summary

As a result of this lesson, you can use the following forms:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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LESSON 4 — PROJECT SETUP

Lesson Durat ion: 45 minutes

Lesson Object ives

After completing this lesson, you will be able to:

l Create a new project

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register
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4 . 1 JOB CREAT ION

In InEight Estimate, a job represents the folder containing your estimate (or version of your estimate),
including its related bid items, cost breakdown structure, resources, quotes, and change logs. All the
jobs in your organization are stored in the Job Register.

To create a new job, select File and then New in the InEight Estimate Backstage view. You can then
choose from several job creation options. The image and table below show the available options.

Option Description

Scratch Creates a new job folder from scratch that is empty, containing no existing data.

Template Creates a job from an existing template from the Template Register. For more
information, see Templates.

Existing
Job

Creates a job from an existing job from the Job Register. For more information,
see Copy an Existing Job.

Bid Wizard Uses a wizard tool to create a new job by selecting pay items and/or cost items
from an existing source job. For more information, see Bid Wizard.

Archive Creates a new job from an Estimate Job Archive (.est) File. For more information
on creating and using job archives, see Archive and Restore Jobs.

Snapshot Creates a new job from a register containing snapshots for all jobs. You can
filter the register of snapshots to find the snapshot you need. For more
information, see Snapshots.
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4.1.1 Create a job from scratch

When you need a clean estimating environment that is not based on any past work, select Scratch.
Creating a job from scratch gives you complete flexibility and ensures that no assumptions are carried
forward from past estimates.

4.1.2 Platform project association to job

When you create a job, it must be associated with a project in InEight Platform. The Platform project
represents the overall construction project being managed by your organization, from planning
through execution and turnover.

The association to a project in Platform promotes data consistency, helps ensure that the data is being
pulled from a single source of truth, and reduces duplicate entries.

Fields in Setup > Job Properties > Overview that are maintained in Platform and integrate into Estimate
include Project ID, Organization, Project Name, and Project Notes. Fields on the Cover Sheet tab such
as Location, City, State, Country, Latitude, Longitude, Forecast Start, Forecast Finish, and Duration can
also be maintained from the associated Platform project.

When modifications are made to integrated fields in Platform and then saved, the changes
automatically appear in Estimate. For example, if you change the project name in Platform to reflect a
new year or phase, that update appears in the Project Name field in Job Properties.

When creating a new job, select a project in the Core Project field in the New Job window to associate
the job with its Platform project.
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4.1.3 Organization breakdown structure (OBS)

Associating Platform projects lets you organize estimates directly from Platform’s OBS. Because
projects in Platform are organized in an OBS, associating your job (estimate) to a project in Platform
allows your estimates to be included in that organizational structure.

The OBS represents the hierarchical structure a company uses to manage its business and can be
broken down in multiple ways, such as Southwest or Northwest regions. Within those regions the
hierarchy can be further broken down by divisions, such as Electrical, Paving, and Masonry. The
organization can continue to be more refined to the level such as states, cities, districts.

After the job you create is associated to a Platform project, in the Job Register, you can view the job in
the context of your OBS. In the example below, the job register is filtered to the Tantalum Group >
Estimating > Site Work level of the organization. Under project ID number 5013592, you can see two
jobs, the original estimate and a second version.
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Your location assignment in the OBS determines the access you inherit and the visibility you
have to other areas of the OBS.

For more information, see Job register overview.

Create a new job from scratch

1. From the Backstage view, select to create a new job from scratch.

2. In the New Job dialog box, click in the Core Project field to select a Platform job from the list.

3. Modify the Code field as needed.

4. Enter a description of the job in the Description field.

5. Determine if you want to select the Auto-Update Job in Connected Analytics check box.

6. Click OK to create the new project.

4 . 2 PROJECT CREAT ION

You can create new projects in InEight Platform’s root and sub-organizations to which you can then
associate Estimates jobs. For example, you can create new projects in a node of the organization
dedicated to estimating, permitting estimators to create and manage projects for the opportunities
they are pursuing while allowing the rest of the organization to maintain a higher level of security over
active projects.

For more information about project creation, see Project Initiation in Platform.
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4.2.1 Considerations

You must have a Level 3-Account Admin role or the Add projects permission in your role.

4 . 3 JOB REG ISTER OVERV IEW

The Job Register contains all the jobs created by your organization and includes columns showing job
properties and other job details to make it easy to view, group by, and filter job information for job
management and reporting purposes.

4.3.1 Open the Job Register

You can access the editable Job Register from the Backstage view by selecting File > Jobs > Job
Register.
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You can also open a non-editable version of the Job Register from File > Open. This version is used to
locate and open a job without exposing the full editing features of the register.
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4 . 4 MANAGE JOBS FROM THE JOB REG ISTER

The Job Register lets you perform many tasks to manage your jobs. You can perform tasks such as:

l Load jobs.

l Edit job details

l Open and edit a job's properties.

l Use the columns to group jobs.

l View and upgrade data versions.

4.4.1 Load a job from the Job Register

You can load (open) a job from the Job Register by:

l Selecting a job, and then clicking Load from the Actions tab.

l Right-clicking a job's row header, and then selecting Load.
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l Double-clicking the row header of a job.

4.4.2 Open a job’s properties from the Job Register

You can also open the Job Properties form of a job from the Job Register by:
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l Selecting a job, and then clicking Properties from the Actions tab.

l Right-clicking a job’s row header, and then selecting Properties.

4.4.3 Edit job details

Many fields in the Job Register are editable, so you can make changes to job details directly in the
register without needing to open the job and its job properties.

The table below summarizes key columns available in the Job Register and indicates which of them are
editable.
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Columns Description
Editable from
Register

Job Properties Cover
Sheet related columns

Columns such as job status, location, city,
state, country, engineer, owner, architect,
estimator, contract duration, forecast start
and finish dates, and liquidated damages.

Yes, for fields that only
exist in Estimate.
No, for fields that come
from the associated
Platform project.

Quote Management Quote information including Request for
Quote (RFQ) contact and minority info.

Yes

Job Folder Tags Custom tags defined by your organization
for organizing and managing jobs.

Yes

Project/Organization The Project ID, Project Name, and
Organization level associated with each
job.

No. The Project ID
fields contain links
that take you to the
project’s details within
Platform.

Notes General notes entered for the job. Yes

Project Notes Notes entered in the project's details in
Platform.

No

Last Saved The date and time the job was last saved. No

Job Created By The name of the user that created the job. No

Source Job The source job or template the job was
created from (if it wasn’t created from
scratch).

No

Upgrade Required The column check box is selected if the job
was created in a previous release of
Estimate and therefore needs to be
upgraded to the latest release.

No

You can make changes in the register by clicking any editable field and editing the content. This
includes free-form text fields and validated fields with drop-down lists.

When changes are made, the register’s Close button changes to Save Modified Jobs and Close, which
you can select to save the changes and close the register.
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4.4.4 Edit jobs in bulk

The Job Register includes functionality to edit the job properties of multiple jobs in bulk.

Edit job properties of multiple jobs

1. From the Job Register, select multiple jobs by selecting the row headers of multiple jobs while
holding down the CTRL or Shift key.

2. Right-click the selection, and then select Properties. This opens the Multi-Edit Job Properties
form. Fields that display Varies indicate different values across the selected jobs, and items
shown in red can be edited.
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3. Edit fields in Job Properties as needed, and then click Save. The changed properties are updated
in the Job Register.

4.4.5 OBS filter tree

You can use the Organization Tree Filter to see where estimates are located in the OBS.

When the Organization Tree Filter is enabled, you can see the jobs that are associated with an
organization tree node in the new OBS filter tree. This helps you to quickly locate and organize
estimates inside of an organization hierarchy.
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If you group by Project ID, and then select a node in the organization, you can see all the projects and
their associated estimates belonging to that part of the organization. For example, there are three
estimates associated with project 4985362 and one estimate associated with projects 4992404,
5013592 and 5013787. This view shows you the relationship between all the project and estimate
associations.
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4.4.6 Data Version and Upgrade Required columns

There are two columns in the Job Register that help you identify a job’s current data version and
whether an upgrade is required:

l Data Version - Identifies the current data version of the job, which might be different from the
Estimate application version. This column is not part of the standard view and must be added.

l Upgrade Required - identifies jobs that require an upgrade to match the current database
version before they can be used in the application. The jobs that require an upgrade have the
check box selected.
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In the Job Register, you can modify attributes for non-upgraded jobs, such as tags prior to
loading the job to force a job upgrade.

4 . 5 INE IGHT PLATFORM PROJECT
ASSOC IAT ION

To create a job in Estimate, you must associate it to a project in Platform. Associating Platform projects
lets you organize estimates directly from Platform’s Organizational Breakdown Structure (OBS). Your
location assignment in the OBS determines the access you inherit and the visibility you have to other
areas of the OBS. For more information about associating a job to Platform, see Job creation.

Extracting Platform project master data directly into Estimate promotes data consistency and helps
ensure that the data is being pulled from a single source of truth.

Platform project-specific master data is maintained in one place, and then flows directly into Estimate
in the cloud. Certain project data such as location and forecast start and finish dates are maintained in
Platform which helps to enforce data consistency and reduce duplicate entries.

The table below shows the fields maintained in Platform's Project details that integrate with the
Estimate's Overview tab in Job Properties.
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InEight Platform InEight Estimate

Project ID Project ID

Organization Organization

Name Project Name

Notes Project Notes

The table below shows the fields maintained in Platform's Project details that integrate with Estimate's
Cover Sheet tab in Job Properties.

InEight Platform InEight Estimate

Address 1 Location

City City

Country/Region Country

State State

Latitude Latitude

Longitude Longitude

Forecast start date Forecast Start

Forecast finish date Forecast Finish

In Estimate, the Project ID field is a hyperlink field. You can click the hyperlink to navigate directly to
the project Details page in Platform.
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Modifications made to any of the integrated fields in Platform automatically show in Estimate. For
example, when you change the project name in Platform to show the year 2025 instead of 2023, the
change is reflected in the Project Name field in Estimate Job Properties.

4.5.1 Job register grouped by Platform project

Grouping by organization lets you see projects batched at an organizational breakdown level and view
Platform-derived projects in their organizational context.
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4.5.2 Manage multiple Estimate versions in the Job Register

An advantage to associating Estimate with Platform project data is the ability to manage multiple
versions of estimates from one source project.

For example, if you have multiple addendums issued for the same project, you can maintain a version
of the estimate for each addendum you’ve received.

Grouping estimates together using a common project means there is no need to structure and enforce
a job coding scheme in Estimate through Job Code, tag fields, or user-defined fields just to identify and
manage different versions of the same project in the Job Register.
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4 . 6 JOB PROPERT IES

When you create a new job, the Job Properties form automatically opens. This is where you enter and
maintain core job information. You can also open Job Properties from the Setup tab by selecting Job
Properties.

4.6.1 Overview tab

The Job Properties form opens to the Overview tab. The image and table below show the Overview
options:
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Name Description

1 Code The unique code for the Estimate
job.

2 Status Current state of the job, such as
Bidding, Awarded, or Completed.

l When searching for jobs in
the Job Folders list, you can
filter and sort jobs by their
status.

Overview Tab
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Name Description

l You can set statuses for jobs
to fit your company
requirements in the Job
Register > Actions > Tools >
Job Status.

3 Project ID Information in this field originates
from the Platform project the
estimate is associated with and
cannot be changed. You can click
the Project ID link to navigate to the
project in Platform.

4 Organization Information in this field originates
from Platform.

5 Description You can enter an estimate-specific
description for the job. You can edit
the description at any time.

6 Project name Information in this field originates
from the Platform project the
estimate is associated with and
cannot be changed.

7 Notes Add estimate-specific notes, such
as when you are creating multiple
estimate versions for the same
Platform project. For example, you
can enter This version is per
addendum #1, This version is per a
specified design change, or This
version incorporates last-minute
scope changes.

8 Project Notes Information in this field originates
from the Platform project the

Overview Tab (continued)
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Name Description

estimate is associated with. The
notes can be added and edited at
any time in Platform to document
specific project-level details.

9 Job created by Indicates the user or entity that
initially created the job.

10 Source job The name of the original job that
the job was copied from.

Overview Tab (continued)

When you copy a job, the new job shows the name of the person who created the copied job,
and the name of the source job the job was copied from.

4.6.2 Cover Sheet tab

The Cover Sheet tab is where you define much of the general project information used to classify and
report on the job. It includes fields for location, contacts, bid details, and schedule-related dates.

The following fields are available:

l Job Location

l City, County, Country, Province/State

l Job Type

l Engineer

l Owner

l Architect

l Forecast Start and Forecast Finish

l Bid Date and Bid Time

l Bid Location

l Estimator

l Opening Type and Proposal Type
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l Liquidated Damages (if applicable)

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.

4.6.3 Cost Basis tab

The Cost Basis tab contains core settings that affect how costs are calculated in your estimate. The
numbered areas shown below are the settings you typically review first.

Name Description

1 Standard Shift
Arrangements

The default standard shift arrangements are set up as 8 hours per shift,
1 shift per day, and 5 days per week; this can be changed if a project
requires a different standard shift arrangement.

2 Standard
Wage Rate
Composite:

Allows you to indicate what percentage of your labor hours will be
regular time (Scale 1), overtime (Scale 2) or double time (Scale 3). You
can enter these percentages manually, or you can use the Shift Rate
Calculator to obtain a more accurate figure.

3 Lock Cost
Items to Pay
Items:

When Cost Items are locked to Pay Items, your level 1 estimate
structure is controlled by your list of pay items.

4 Default The default will be set to U.S. Dollar, but this can be changed if
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Name Description

Currency: needed.

5 Sales Tax
Rate:

This field is not required but may be used to automatically apply a sales
tax to all your material and rental items. The default is set to zero.

Cost Basis tab overview

4.6.4 Shift Rate calculator

Use the Shift / Rate Calculator when you need to calculate a labor composite based on the actual shift
pattern for the project instead of entering percentages manually.
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Shift rate calculator

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

2. For Shift 1, type a number value of hours in theMonday through Friday Work Hours fields.

l You can enter up to three shifts for the project

3. For Shift 1, type a number value of hours in the Scale 1 fields.
l Scale 1 will be your regular time and Scale 2 will be any overtime

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).

5. For Shift 2, type a number value for hours as you did above in Step 3.

6. Click OK.
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l Now you have a blended shift arrangement, and your labor rates are a blend of
64.18% straight-time and 35.82% overtime

4.6.5 Import filtered resources

You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use
it to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update
and have the “Latest & Greatest” rates available to import into your estimates.
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You will import the rates you need using a set of Resource / Assembly filters. Especially for labor rates,
filtering by these attributes allows you to pare down the master list to only the resources you need.

Each of the resource filter categories are open for use as determined best by your business. The
following are examples of common uses:

Resource Attribute Filters

Name Description

Resource File
Description

This attribute can be used to designate the rate type or the year to which the
rates pertain.

Geographic
Area

This attribute is used to designate regions, cities, or provinces based on
geographical location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example,
it may designate the trade and union agreements your labor resources
belong to.

Organizational
Category

This attribute can be used to designate what trade or work type your
resources pertain to.

Resource filters become more specific from left to right, so start with the broader filters on the left and
then move to the more specific filters on the right. The geographic area, wage zone, and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

When filtering resources, work from left to right through the filter lists to narrow the available
options efficiently.

You can sort the filter lists by clicking the filter category titles.

The following steps walk through using the Resource Filter to import resources.

Import filtered resources

1. In your Job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.

2. Under Resource File Description, select Standard Labor Rate File.
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3. In the Geographic Area, select an Area.

4. For Wage Zone (Work Center), select aWage Zone.

5. For Organizational Category, select All.

6. Follow the same steps for the remaining resource types.

7. Select the Import Filtered Resources button to bring your selected resources into the job.

l For this example, we'll select the following filters for the Labor resource type:

You must select “Import Filtered Resources” to import your resources. Clicking OK on the Job
Properties form will not import your resources.

4.6.6 Fuel Cost tab

On this tab, you can enter the cost for fuel or other energy sources. These unit costs are multiplied by
the consumption rates entered on each equipment record to define the operating fuel cost of each
piece of equipment. The Cost per UM fields default to $0.00 until you enter values.

Enter fuel costs

1. In your job, open the Job Properties > Fuel Cost tab.

2. In Cost Per UM column, enter a dollar amount into the following:

l Diesel

l Gas & Gasoline
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l Off Road Diesel

3. Currency should read U.S. Dollar and UM should read Gallon.

4.6.7 Job Folder Tags tab

On this tab, you can enter tag fields to label your project, so you can reference it later.

Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags

Page 232 of 419 InEight Inc. |  Release 26.5

4.6 Job properties Estimate User Guide



are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.

4.6.8 Schedule tab

The Schedule tab is used to define scheduling options for integrating Estimate with InEight Schedule,
Microsoft Project, or Primavera. The settings you define determine what information is sent to your
scheduling tool and how it is structured.

l Integrated Schedule – Select your integrated schedule from InEight Schedule, Microsoft Project,
Primavera, or Manual.

l Schedule Currency – When you use Microsoft Project or Primavera, you can select the currency
type used for the integration. The InEight Schedule and Manual option is set to U.S. Dollar by
default.

l Plug Days - You can select Always use Plug Days when updating Estimate from schedule.

l Cost Item Roll Up – You can select to automatically calculate plug days when rolling up cost
items for scheduling purposes.
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4.6.9 Other Job Properties tabs

There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.

Other Job Properties Tabs

Name Function

Minority Setup Used to set up minority participation goals (for example, DBE or MBE) and
you want to track minority participation goal attainment status during the bid
process,

Job Tracking Used to select the code that will be used when tracking job progress, define
the planned production calculation, define the percent complete calculation,
define the forecast methods, and define markup rates for calculating earned
revenue on Time and Expense pay items.

Pricing Used to define how you want the Balanced Unit Price for each of the job's
pay items to be calculated when using the AutoPrice feature. You can also
choose form several options in determining how markup is defined.

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation
of Job Financing and cost/revenue realization to generate the curves that
display on the Cash Flow form.

Equipment
Maintenance

Used to define the calculation of maintenance labor man-hours based on
equipment utilization, to capture the impact on total man-hours when
changes are made that affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current
job, and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.
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Exercise 4.1 — Define Job Properties

In this exercise, you will continue to define your Job Properties from the job you have created in two
parts. Complete the following steps:

1. On the Cover Sheet tab, fill out the following fields:

Field Value

Job Location I-10 MP 100 to MP 120

City Phoenix

County Maricopa

Country United States

State Arizona

Type Highway and General Engineering

Engineer Example Engineer -- Fred Jones

Owner Example Owner -- Jerry Slate

Architect Example Architect -- Robert Frost

Contract Duration 160

Time Measure Contract Days

Forecast Start 1/6/2014

Forecast Finish 6/5/2014

Duration (days) 150

Bid Date and Bid Time 12/23/2013 10:00:00 PM

Estimator Example Prime Contractor 1 -- Tom Cross

Opening Type Public

Proposal Type Unit Price

Plan Holders 5
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In this part 2 of this exercise, you will continue to define your Job Properties from the Job you have
created. Complete the following steps:

2. On the Cost Basis tab:

l Ensure the Standard Shift Arrangements are 8.00 work hours per shift, 8.00 pay
hours per shift, 1.00 shift per day, and 5.00 days per week.

l Ensure the Standard Wage Rate Composite is set to 100.00% Scale 1, 0.00% Scale
2, and 0.00% Scale 3.

l Ensure the Sales Tax Rate is set to 0.00%.

You should end up with similar results

The following Cover Sheet properties are defined:

The following Cost Basis settings are defined:
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Congratulations, you have completed this exercise!
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4 . 7 PAY ITEM CREAT ION

Pay items typically represent the owner-required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees, or contingency calculated in the Price Breakdown Structure to a defined
list of items. This allows the total estimate value to be distributed to a structure that is different than
the CBS. Pay items are commonly used by contractors to prepare bid sheets, and owners may use them
to identify funding sources or support reporting requirements.

Many bid forms are organized by grouping bid items for related scopes of work. Pay items in the Pay
Item & Proposal Register can be grouped in a hierarchy by using the Position Code column.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab and then Pay Item & Proposal.

Name Description

1 Proposal and Item
Recaps

Related to pricing during bid close-out. You can disregard them at
this time.

2 Pay Item Number Represents the bid item number from the client, if one is
provided, or a number that you define. This field is alphanumeric.

3 Position Code Controls how pay items are grouped and gives you an efficient
way to sort and build a hierarchy.

4 Description You can enter a pay item description.

5 Pay Quantity and
Forecast (T/O)
Quantity

The Pay Quantity is the quantity provided by the client.
The Forecast (T/O) Quantity is your measured quantity for the
item.
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4.7.1 Overview – Pay Item & Proposal Register

Create a pay item

1. Open your job and select Setup tab >Pay Item & Proposal from the InEight Estimate landing
page.

l The Pay Item & Proposal Register displays

2. In the Pay Item Number column, in the first blank row, type a number value.

3. Use the Tab key to move to the Description column and type a description.

4. Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

l The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be
changed later

l You can tab to the next row to create additional pay items if needed
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4.7.2 Pay item prices by category

Owners are increasingly requiring more information from contractors as part of their bid submissions.
Many times, this is a further breakdown of a bid price such as separating the price of an item based on
its labor cost, material cost or man-hours. Select columns in the Pay Item & Proposal register enable
users to summarize their pay item prices by up to 10 price categories.

In addition to seeing the price by category, these additional columns also give users better visibility
into how the price is established, including columns for the total cost, total distribution, total markup
and markup percent. These new columns make it easier to verify that the distribution of unassigned
cost and markup are calculated as intended by the estimator.

4.7.3 Standard Proposal report

The Pay Item Standard Proposal report is located in Execution > Reports > Pay Item & Proposal >
Standard Proposal. It is intended to be used as a bid form that can be distributed to clients, partners,
and contractors. In the Details box below, you can determine which key fields are included in the
report.
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Exercise 4.2 — Create pay items

In this exercise, you will practice creating pay items in the Pay Item & Proposal Register. Complete the
following steps using a job of your own, and use the Position Code column to create the parent and
child hierarchy shown below.

Position
Code

Pay Item
Number Description

Pay
Quantity

Unit of
Measure

1 200 SITEWORK & 
ROADWAY

1.1 641 0100 Mobilization 1.00 LS

1.2 201 0102 Clearing & Grubbing 10.00 Acre

1.3 202 0183 Excavation 50,000.00 CY

2 400 WATER & SEWER

2.1 800 0220 10 PVC Pipe 1,000.00 LF

You should end up with the following results:

Congratulations, you have completed this exercise!
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Lesson 4 - Review

1. This is where you enter basic information about the job as well as define your cost basis.

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. On the Job Properties form, this tab is where you enter information such as the start
date, bid date, job type and location.

a. Overview

b. Cover Sheet

c. Cost Basis

d. Foundation Setup Data

3. These are the project deliverables; anything the owner agrees to measure and pay for.

a. Cost Items

b. Resources

c. Target Price

d. Pay Items

Lesson 4 - Summary

As a result of this lesson, you can:

l Create a new job

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register
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LESSON 5 — D IRECT COSTS

Lesson Durat ion: 90 Minutes

Lesson Object ives

After completing this lesson, you will be able to use the following forms and explain their purpose:

l Utilize the Cost Breakdown Structure

l Create cost items

l Add costs and production

l Manage cost item details
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5 . 1 COST BREAKDOWN STRUCTURES

The Cost Breakdown Structure (CBS) is the main form where you do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure from the InEight Estimate landing page, select the Estimate
tab > Cost Breakdown Structure (CBS).

The following image and table show an overview of the CBS.

Name Description

1 Actions
Menu

Shortcut icons allow you manage cost items and import and export them
from other sources such as Microsoft Excel. You can filter cost items and
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Name Description

select to include the subordinate items when filtering.

2 CBS
Tree

Filter
Mode

The CBS Tree filter shows the CBS hierarchy and is used to quickly help
filter cost items, instead of scrolling the CBS to locate certain cost items. The
CBS Tree Filter lets you choose between a filter mode or a new navigation
mode.
Both Filter and Navigation modes on the left side of the page gives you the
visibility of your entire CBS structure, as well as the option to navigate and
filter throughout the CBS estimate. The Cost Item record can also be tiled
next to the tree to make navigating and filtering possible, while viewing all
the cost item record details at the same time.

3 Left CBS
register

This side of the register contains all of the estimate activities (cost items) that
you create or import, organized into a superior-subordinate hierarchy.

4 Right
CBS
register

This side of the register contains numerous columns for cost detail,
production values, and user-defined tags and fields.

5.1.1 Cost item terminology

The CBS contains both direct and indirect costs.

l Direct Cost Items contain costs that pertain directly to the deliverables of the project. Therefore,
direct cost items are typically assigned to pay items

l Indirect Cost Items contain overhead costs that are not directly associated with particular
deliverable items but contribute to the total cost of the project (e.g., supervision, site office,
safety supplies, bid securities). Occasionally an indirect cost item may be assigned to a pay item
(e.g., Mobilization costs that are indirect but assigned to a Mobilization pay item).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Terms Description

Superior A Superior cost item has subordinate (child) items below it that determine
hours and costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.
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Terms Description

Terminal A Terminal cost item has no subordinate items. Resources, costs, and
production can only be added at the terminal cost item level.

A Terminal cost item may or may not be a subordinate.

The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As costs
are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost items.

A superior cost item can have no costs of its own; its costs are strictly the rolled-up total from
the subordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

5.1.2 Work breakdown structures

The Work Breakdown Structure (WBS) allows you to reorganize the estimate using different formats
such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats are used
when you need multiple variations and summary reports of an estimate. The WBS retains the same
relationships between items as in the original estimate while only changing the view and items
arrangement in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Name Description

1 WBS
Tree

Use the WBS Tree to filter to a particular WBS item.

2 WBS When a specific WBS item is selected in the WBS

Overview – Work Breakdown Structure (WBS) View
Register
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Name Description

Grid Tree, all subordinate WBS items display in the WBS
grid.

3 Cost
Items

The Cost Items associated with the WBS
subordinate in the WBS Grid displays in this data
block.

Overview – Work Breakdown Structure (WBS) View
Register (continued)

5.1.3 Locked vs. Unlocked approach

There are two basic approaches to structuring your cost items and pay items. You can choose to work
in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost
items inherit the pay item assignment of superior cost items.
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If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will
automatically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work
plan. You can then assign your cost items to your pay items in any arrangement. Companies looking to
standardize the way they estimate and use templates will want to use this approach as it allows you to
dictate the cost breakdown structure. Owners will also typically use the unlocked approach since pay
items are not necessary to their estimating process.
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The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.

5.1.4 Take-off quantities

In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity
field with a corresponding unit of measure. The quantity will default to 1 each when you create a new
cost item and should be updated to reflect the work being estimated.
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Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.

The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

Adjust take-off quantities

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. In the Forecast (T/O) Quantity column, the Forecast (T/O) Quantity is brought over from the Pay
Item & Proposal Register, but here you can adjust it if needed. Practice adjusting the Forecast
T/O quantity of one of your cost items.

l For this example, we’ll change Clearing and Grubbing to 15.00 Acre and Excavation to
40,000 CY.
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5 . 2 COST ITEM CREAT ION

During estimate development, you will create new cost items to break down your work into specific
activities. You can create superior and subordinate cost items as needed to organize your work.

5.2.1 Insert subordinate cost item

You can add subordinate cost items in two different ways:

Opt ion 1

Right-click on the row header of the superior cost item and select Insert Subordinate.

The row header is considered the far left edge of the CBS row where the small arrow appear appears
above. It is used to open records and perform actions on items instead of clicking on cells within the
row which will allow you to directly type into the selected cell.

Opt ion 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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5.2.2 Insert cost item

You can add cost items at the same level in two different ways.

Opt ion 1

Right click on the row header of the superior cost item and select Insert.
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Opt ion 2

Click on the Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.

Create a subordinate cost item

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on a cost item and select Insert Subordinate.

l This creates a new subordinate cost item below your selected cost item

3. For the subordinate cost item, enter a description.

4. Add a quantity and select your Unit of Measure.

l For this example, we’ll insert a subordinate under Clearing & Grubbing for Clearing

You can create a subordinate at the same level, by right clicking on an equal-level
cost item and selecting Insert.

5.2.3 Move cost items

As you develop your estimate, you may need to move cost items around in the Cost Breakdown
Structure. To move a cost item:
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1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.

2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor
symbols appears:

The symbol with three equal bars will drop the cost item at the same
level as the cost item you drop it on.

The symbol with a subordinate bar will make the cost item become a
subordinate to the one you drop it on.
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Exercise 5.1 — Create cost items

In this exercise, you will practice creating additional cost items. Create the following cost items,
using your own job.

Code Description Forecast (T/O) Quantity Unit of Measure

1.2.2 Grading 10 Acre

1.3.1 Excavate 40,000 CY

1.3.2 Haul 40,000 CY

4.1 Furnish Pipe Materials 1,000 LF

4.2 Excavate-Install-Backfill Pipe 1,000 LF

You should end up with similar results:

Congratulations, you have completed this Exercise!
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5 . 3 COSTS AND PRODUCT ION

For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

5.3.1 Cost item record

You can open the Cost Item Record by either double clicking on a cost item row header, or right
clicking and selecting Open.

Cost Item Record Overview

Name Description

1 Cost Item
Header
Information

Provides general information about the cost item. It displays the cost
item’s take-off quantity, Unit of Measure, and Cost. It also indicates what
Cost Source is being used.

The Cost Segment drop-down is used to differentiate estimated costs in
the Direct Costs, Job Overhead or Business overhead categories.

2 Costing
Area

Section where costs are defined. There are three ways to enter costs:
Detail, Plug, and Quote. The Cost Summary tab summarizes whatever
costs are defined.
Under the Cost Segment drop down, you can choose

3 Data Blocks Contains a set of tabs for entering additional information including
production, shift arrangements, man-hour factors, notes, and scheduling
information.
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5.3.2 Cost segments

The Direct Costs, Job Overhead, and Business Overhead cost segments helps to classify the scope of
work so you can report on direct vs indirect costs, and accurately control how markup is spread
throughout your bid. This differentiation is necessary to effectively price work based on the risk profile
of each segment of cost.
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5.3.3 Cost sources

You can define costs on a cost item in one of three ways, called Cost Sources:

Tab Description

Detail This is the recommended costing method, where labor, equipment, and material
resources are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter
resources or production. This should rarely be used, but does have a couple of use
cases:

l Place holder value until you get more information (from subcontractors or
designers)

l For preliminary estimates when limited information is available

Quote The Quote cost source is for contractors, subcontractors or vendor quotes.
l Creating and managing quotes is covered in Lesson - Quote Management

On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.
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5.3.3 .1 Plug tab

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be
customized based on company requirements.

5.3.3 .2 Deta i l tab

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially
(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
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review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.

The Quote Cost Source can only be selected from the Quote Comparison & Award form.

5.3.4 Plug costs

The following steps walk you through defining a plug cost on a cost item.

Define a plugged cost

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.
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3. In the Cost Source drop-down field select Plug.

4. In the left section of the cost item, select the Plug tab.

5. Click in the Unit cost or Total cost field for a cost category and type in a Numeric Value.

l For this example, on the Mobilization cost item, we’ll add $10,000 in the Total Cost field
for both Labor and Owner Equipment.

5.3.5 Detail costs

The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:

l A duration, or

l A unit per duration, or

l A duration per unit

When you enter a production value, all the other production fields will auto-fill based on what you
entered.
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The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.

When you employ material resources, their costs are driven by the quantity you enter into the quantity
field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

Detail costs

1. On the Detail tab, add resources (labor, equipment, and material).

2. On the Production tab, define production (duration, unit per duration, or duration per unit).

3. The hours defined on the Production tab drive the labor and equipment resources on the left,
multiplying their unit costs by the production hours.
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With material resources, their costs are driven by the quantity entered in the quantity field.

5.3.5 .3 Add cost deta i l

The following steps walk you through adding resources and production on a cost item.

Add cost detail

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on row header for a cost item and select Open.

3. Select the Detail tab.

4. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

5. Select a resource tab (e.g., Labor).

6. Select a resource.

7. Select OK.

8. Repeat the steps to add additional resources as needed.

9. Click in each resource’s quantity field to change their quantity as needed.

10. From the lower-right section of the form, select the Production tab.

11. Type a numeric value in the Days field, then press Tab.

12. Click OK to close the record.
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l For example, we can add cost detail to the Clearing cost item, adding the following labor
and equipment resources and production value:

5.3.5 .4 Add assembly

Define cost detail by adding an assembly

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for one of the cost items and select Open.

3. Select the Detail tab.

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.

5. Select an assembly, then click OK.

6. Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Type a numeric value in one of the production fields (e.g., Lump Sum/day), then press Tab.

For example, on the Grading cost item, you can add a Grading crew with a production value of 1
Lump Sum/Day.

InEight Inc. |  Release 26.5 Page 267 of 419

Estimate User Guide 5.3 Costs and production



Page 268 of 419 InEight Inc. |  Release 26.5

5.3 Costs and production Estimate User Guide



Exercise 5.2 — Define cost detail

For cost items you create in InEight Estimate, you need to add resources, assemblies and production
to define their costs. In this exercise, you will practice defining cost details. Complete the following
steps, using your job:

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

EX225 Excavator 225 1

CY/Hour 400

Add the following or similar resources and production to your 1.3.1 Excavate cost
item.

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

LT1 Teamster 1

EL950 Loader 950 1

ETDT Dump Truck 1

EX225 Excavator 225 1

CY/Hour 400

Add the following resources and production to the 1.3.2 Haul cost item.
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Code Description Quantity

MPP10 Pipe 10” PVC SDR21 1,000 with 5%Waste % Add-on = 1,050 LF

Add the following resource and quantity to the 2.1.1. Furnish Pipe Materials cost
item.

Code Description Quantity

CPIPE Pipe Crew 1

Add the following assembly to the 2.1.2 Excavate-Install-Backfill Pipe cost item.

Days 3

Add the following production value to cost item.

You should end up with the similar results:

Congratulations, you have completed this exercise!

5 . 4 COST ITEM DETA ILS

The Cost Item Record contains multiple data blocks you can select from to store and calculate
information specific to that cost item.
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Depending on the cost item circumstances, you can add to or edit the information on the data blocks
as needed. The Notes, Cost Item Setup, Production, and Man-Hour Factors are the most commonly
used data blocks.

5 . 5 NOTES

On the cost item record’s Notes data block, you can enter any cost item-specific notes that provide
instructions, parameters, or explanations such as in the following examples:

l For a Hauling cost item— There should be very little waste. If so, we can spread it out in the
right of way at MP 111

l For a Structural Excavation and Backfill item— The backfill cannot be the native material. Must
use clean base rock

l For an Underground Pipe cost item— The average depth is close to 10 ft.

You can also use the Notes data block to reference cost item changes (e.g., changing shift
arrangements, changing a resource rate).

InEight Inc. |  Release 26.5 Page 271 of 419

Estimate User Guide 5.5 Notes



5 . 6 COST ITEM SETUP

On the Cost Item Setup data block, you can adjust wage scale and shift arrangements for a specific cost
item.
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The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is inherited from the composite wage
scale and work and pay hours defined on the Job Properties > Cost Basis tab for the current job. These
settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the row
of the subject cost item.

5.6.1 Cost curves

Cost curves are used to determine how the cost of a cost item is distributed over time. The main
benefit of defining the cost curve for a cost item is to create a more accurate estimation of the cash
flow over the life of a project.

The schedule dates entered on a cost item are used to define the periods across which a cost item
incurs its costs. A cost item’s start and finish dates can be entered manually by the user or established
using Schedule Integration, and the time periods (day, week, month, quarter, year) are determined in
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the Cash Flow settings in Job Properties. For more information about scheduling, see InEight Schedule
Integration.

By default, cost items have a linear cost curve, which distributes the cost equally across all periods for
the cost item. There are 5 different types of cost curves that can be selected from the Cost Item Record
> Cost Item Setup page.

Cost curve type Definition

Back Loaded Costs are low for most of an activity's timeline
but then increase towards the end. This curve
type starts out with a lower slope and
gradually becomes steeper as the work
progresses. Most resources are assumed to
be consumed later in the activity and may be
more characteristic of subcontracted work
where costs are incurred as the work nears
completion.

Bell Shaped Expenses are low at the start of an activity,
increase during construction, and decrease
as the project approaches completion. Bell-
shaped cost curves incur most of their costs
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Cost curve type Definition

towards the mid-point of the work and
exponentially increase and decrease from
the beginning to the end of the activity. This
type of curve can be characteristic of larger
portions of work that start with a few
resources, ramp up to a peak, incurring more
costs during the ramp up, then ramp back
down as the work nears completion.

Front Loaded A front-loaded cost curve is when costs are
incurred early in an activity. This can happen
for several reasons, such as early
procurement of materials to take advantage
of lower prices or to address long lead times.

Linear Linear cost curves take the total cost of the
activity and spreads it equally amongst the
specified periods.

Cost Item Periods Invoked by using the Period Quantities
feature (described below). Cost Item Periods
are used to customize cost curves based on
the quantities consumed in various periods.
In comparison to the other curves which
spread the items total cost proportionally
based the chosen cost curve, the Cost Item
Periods option can generate a more precise
distribution of costs to specific periods
because the user can simply define how
much quantity of work is getting completed in
each specific period.

(continued)

You can also choose to create your own custom cost curve by clicking the Add button in the Cost Curve
drop-down menu.
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Custom cost curves let you define your own from and to durations along with their associated values,
which need to add up to 100%.

5.6.1 .1 Cash f low

All cost curves, regardless of type, impact the generation of the cash flow graph. The Cash Flow form
provides a graphical representation of the cash flow and resource utilization of your project. For more
information, see Cash Flow Overview.

The Cash Flow options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project. For
more information, see Cash Flow Options.
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You can control what information shows on the Cash Flow graph in the cash flow display settings. For
more information, see Cash Flow Display Settings.

5.6.1 .2 Per iod quant i t ies

Like the other four cost curves, Period Quantities are used to customize cost curves, which show you a
graphical representation of the cash flow and resource utilization so you can assess the proper
financing and resource project needs. When the Period Quantities check box is selected, the Cost
Curve automatically changes to Cost Item Periods.

The Period Quantity calculator uses the cost item quantity assigned to various periods to calculate the
specific percentages attributable to each range of periods covered by the cost item. The purpose of
using period quantities is to spread costs via the cost curve in the cash flow analysis. For example, if
you have an item where 50% of the cost is incurred when you start the work because you have to buy
all the material first, then you would want a customized cost curve to reflect that this is how the costs
will be incurred over time when building that work.

In the example below, since 50% of the cost is incurred when the project starts, period one's quantity
is 50% of 45,000 Forecast (T/O) Qty, which is 22,500. The remaining costs are then spread equally
across the remaining three periods.
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You can also choose to select the Re-spread quantities button to spread the quantities equally among
the periods entered in the Number of Period Quantities field.

Page 278 of 419 InEight Inc. |  Release 26.5

5.6 Cost item setup Estimate User Guide



Adjust shift arrangements

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click the row header for a cost item and select Open.

3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your Composite Wage Scale as needed.

5. Under the Composite Wage Scale, adjust the number of hours and paid as needed

6. In the Default Shift Arrangements data block, make changes as needed.
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l For this example, we’ll make the following changes on the Clearing cost item:
o Composite Wage Scale – 80% Scale 1, 20% Scale 2.
o For every 10 hours worked, pay 10 hours.
o Default Shift Arrangements – Change Work Hours per Shift to 10.

5 . 7 MAN-HOUR FACTORS

For items that have known risks or potential resource concerns, you can apply a man-hour factor to
take those risks into consideration.

Man-hour factors are applied on the Man-Hour Factors data block on the Cost Item Record. Factors are
applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

Man-hour factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Page 280 of 419 InEight Inc. |  Release 26.5

5.7 Man-hour factors Estimate User Guide



Even after defining a man-hour factor, the Production data block still shows the original Production
values.

l Both original and factored production are then shown on the Production data block.

l Use the Customize icon to add or remove fields from the Production view.
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You can apply man-hour factors to multiple cost items at once by multi-editing selected cost
items on the CBS Register.

5 . 8 UN IQUE IDENT IF IER

You may have noticed that when you make changes to the Cost Item Setup data block, the fields you
changed and the Cost Item Setup data block are highlighted, indicating that they were altered from
their original state.

On the CBS Register, the cost item you edited now has a Unique identifier icon in the row header
indicating the cost item has been altered from the default values set in the project job properties or in
the project library of resources rates.
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When you hover over the identifier, a message shows indicating what data points were changed.

The unique identifier is also shown for resources when you make changes to the employed resource
cost to be different than the original resource rate imported from the Resource Rate Register.
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5.8.1 Highlight unique (delta) toggle

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.

5 . 9 COST DR IVERS

Each type of resource has a default cost driver. For example, Labor resources are duration driven, so
the cost driver is CI Duration, meaning their costs are driven by the duration of the cost item. If you
want an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.
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With CI Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let us say you want your Operator to work specifically 80 hours.

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.

If you want to set it at 80 hours no matter what changes you make to your quantity, you can change
the cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the
Operator will not change and will remain at 80 hours as shown below.
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If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to CI Duration and the Work Hours back to 100.

5 . 10 SUSPEND COST ITEMS

The Suspend feature lets you turn cost items on and off to performWhat-if analysis or evaluate
alternative approaches to the work.

A cost item can be suspended in InEight Estimate for multiple reasons including the following:

l Manually suspended cost items

l Suspended parent

l Parent with cost source that is not Detail (plugged or quoted)

l Parent cost item with a zero quantity

l Pay item is suspended

l Allocated cost items

l Alternate scenarios:
o Overridden by another alternate
o Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be
unsuspended at any time to be included in the total project value.
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Suspend a cost item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right-click the selection and select Toggle Suspended from the menu.

l You can also select Toggle Suspended under the Edit section of the Actions tab at the top
of the register.

l You can also suspend cost items by checking the Suspend check box on the Cost Item
Setup data block of a cost item record.

l If a superior cost item is suspended, its subordinate cost items are automatically
suspended as well.
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l The costs associated with these cost items no longer contribute to the estimate.

5.10.1 Editable man-hour factors in suspended cost items

You can edit man-hour factors for a suspended cost item by creating and maintaining cost items,
including man-hour factors. This can be accomplished in a suspended state while having the scope of
work included in your estimate. The cost to contribute is excluded from the scope of work until you are
ready to make it part of your estimate.
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Unsuspend a cost item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right-click the selection and choose Toggle Suspended.

l You can also select Toggle Suspended from the Edit section of the Actions tab

l You can also unsuspend cost items by unchecking the Suspend check box on the Cost Item
Setup tab of a cost item record.

5.10.2 Suspend column

In the CBS Register, the Suspend column indicates which cost items are suspended.
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l Hover over the check mark boxes to see why the cost item is suspended.

l You can suspend and unsuspend cost items by checking and unchecking the check boxes.

5 . 11 COST ADJUSTMENTS

Total cost and billing adjustments can be made in the CBS register which can be viewed from the Cost
Items Adjustment view, or a saved view affiliated with change.
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In the Cost Item Adjustment view, you can view and modify the adjustment amount and adjustment
percent without going into each individual cost item.

Any adjustment made to the Adjustment Amount fields on the CBS register has the Adjustment
Percent field automatically calculated. Changes made to those fields are highlighted in yellow,
signifying that an adjustment has been made.

Other adjustments fields in the CBS register include the many adjustments fields added to the Billing
Rates view.
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Exercise 5.3 — Manage cost item details

In this exercise, practice adjusting your cost item details. Complete the following steps, using your
Job:

1. Open the Cost Item record for cost item2.2 Grading.

2. From the Cost Item Setup tab, change the Composite Wage Scale to 80% Scale 1,
20%Scale 2. Also adjust for every10 hours worked, pay 10 hours.

3. Change the Default Shift Arrangements to 10Work Hours per Shift, 1 Shift per Day, 5Days
per Week.

4. From the Man-Hour Factors tab, apply a Man-Hour Factor of 1.1 to the same cost item.

5. On the Notes tab, type Added man-hour factor due to hard soil conditions.

You should end up with similar results.

Congratulations, you have completed this exercise!
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Lesson 5 - Review

1. Resources, costs, and production can only be added to what type of cost item?

a. Superior

b. Terminal

c. Parent

2. What Cost Source is used for defining resources and production?

a. Plug

b. Detail

c. Quote

3. On the Cost Item Record, what tab is used for changing the cost item’s Default Shift
Arrangements?

a. Cost Item Setup

b. Production

c. Man-Hour Factors

d. Notes

Lesson 5 - Summary

As a result of this lesson, you can:

l Utilize the Cost Breakdown Structure

l Create cost items

l Add costs and production

l Manage cost item details
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LESSON 6 — IND IRECT COSTS

Lesson Durat ion: 45 Minutes

Lesson Object ives

After completing this lesson, you will be able to:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items
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6 . 1 IND IRECT COSTS OVERV IEW

Indirect costs such as the cost of prime bond, mobilization, or site supplies are typically overhead costs
that are not directly associated with a particular project deliverable but contribute to the total cost of
the project. However, indirect costs can be assigned to a pay items. This gives you the flexibility to
more accurately control the cost basis of bid items and strategically price the work to maximize cost
recovery and profit.

Once your direct costs are defined, you can add indirect project costs. Estimate provides two ways you
can create indirect costs:

1. Default Indirect Cost Items:  These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

2. User-Defined Indirect Cost Items:  Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.
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The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab, Master
Breakdown Structures section, controls which of the default indirect cost items to copy
into new job folders.

6.1.1 Navigation to Indirect Costs

From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

l Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

l You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.

6 . 2 DEFAULT IND IRECT COST ITEMS

InEight Estimate contains various default cost items to help you calculate your indirect costs.

6.2.1 Independent indirect cost items

Independent indirect cost items function very much like the direct cost items you defined previously:

l Job Management & Equipment

l General Expense
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6.2.1 .1 Job Management & Equipment

The sample Job Management & Equipment Record below shows that you can add resources and
production just like in your direct cost items. Supervisory staff resources were added, and the
production duration is set to 100 days.

The following Step by Step walks you through defining resources and costs for your Job Management &
Equipment indirect cost item.

Add job management & equipment costs

1. In your job, from the Estimate landing page, select the Cost Breakdown Structure (CBS).

2. Double-click on the row header of the Job Management & Equipment indirect cost item.

3. Add resources by clicking in the Code column and selecting the Icon.

4. Select the Production tab.

5. Enter a production value.

6. Click OK to close the record.
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l For this example, we'll add the following resources and production:

Add general expense costs

1. From the Estimate tab, select the Cost Breakdown Structure (CBS).

2. Right-click the row header of the General Expense row header and select Open.

l You could add existing resources here, but in this case, you will create an ad hoc resource.

3. In the first blank row, enter a description, quantity and unit of measure.

4. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.

5. Type a numeric value in the Undefined Supplies cost category.

6. Click OK to close the record.

l For this example, we’ll add General Office Supplies, 1 Lump Sum, $1,000 in the Supplies
category.
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6.2.2 Dependent indirect cost items

The other default indirect cost items are dependent indirect cost items, meaning their costs depend
on other costs, prices or hours. They include:

l Direct and Indirect Cost Add-On

l Direct and Indirect Cost Escalation

l Prime Bond

l Price % Add-On

l Job Financing

l Man-Hour Add-On

It’s possible to assign any assigned or dependent cost Item to any of the 3 cost segments which
provides greater control over where costs exist in the Price Breakdown Structure (PBS).
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6.2.2 .2 Defau l t dependent cost i tem dele t ion

If you need to use additional dependent cost items, you can create your own, but you must
delete all the existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.

Delete existing default dependent cost items

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Select an Indirect Cost Item by clicking on its row header.

3. Press and hold the Ctrl or Shift key to select multiple indirect cost items.

4. Right-click on the selection, and then select Delete.

5. Select Yes to confirm you want to delete the selected cost items.

6.2.2 .3 Pr ime Bond

The following steps walk you through adding and defining your prime bond for the job.

Define prime bond

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for any cost item and select Insert Dependent cost Item.

3. On the resulting Attention prompt, select based on Bond Rate Table.

4. Click OK.

5. Right-click the Prime Bond row header, and then select Open.

6. Use the Table Name drop-down to choose a table (e.g., Example: General Construction).

7. Click OK to close the record.
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Mul t ip le bond rate dependent i tems

For certain projects, you may want to calculate costs for bond or insurance premiums based upon
multiple different rate tables. You can add multiple bond/rate table based dependent items in the CBS.

For example, in addition to having a prime bond, the job may also require insurance coverage where
the premium is calculated using a rate table-based approach. This can be accomplished by adding
another Bond/Rate table-based dependent cost item to the job.

Additionally, bond premiums can be adjusted by a single amount. This is common when certain
requirements are imposed by the contract, such as extended warranty periods. It is common for the
bond premium to be established using a standard rate table, you can then add additional charges to
the total bond premium amount.
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Delet ing bond tab les

Delete bond tables that are not applicable to your estimate by selecting them and then clicking the
Delete button. You can customize the Bond Table window to only view the tables that are relevant to
your estimate from the Table Name drop-down list.
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Define a price % add-on

1. From the Cost Breakdown Structure (CBS) Register, right-click the row header for any cost item,
and then select Insert Dependent Cost Item.

2. On the Attention dialog box, select Job's Price.

3. Click OK.

4. Double-click on the Price % Add On row header to open the record.
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5. The Price % Add-on Record opens to the Description tab. Enter a description and a numeric
value for rate.

For this example, we’ll enter a description of Office Overhead and a rate of 4%.

6. Click OK to close the record.

Create a direct cost add-on

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item, and then select Insert Dependent Cost Item.

2. On the Attention dialog box, select Direct Costs.

3. Click OK.

4. Double-click the Direct Cost Add-On row header.

5. On the Description tab, type a description in the Description column.
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6. Press the tab key on your keyboard. You can then define additional rows for other add-on costs
as needed.

7. Click the Dependency tab to see what contributes to your subject cost.

8. For this activity, leave the default (lower) button selected.

9. On the Cost Breakdown tab on the right, add an add-on rate (percentage) or cost at any of the
cost category levels you need. This updates the Total Cost (Forecast) of your item on the
Description tab

10. Click OK to close the record.

For this example, we’ll create a new Direct Cost Add-On, giving it a description of Small Tools
with a rate of 10% on the Labor cost category
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6.2.2 .4 Repos i t ion ing dependent cost i tems

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

When you move a dependent cost item from its default location to a new position in the CBS, it’s
assigned a CBS position code based on its new location. The cost item fields listed below are exposed in
the CBS register so you can easily see the various percentages used in dependent items.

l Subject Cost

l Subject Cost Rate

l Subject Billing Amount

l Subject Billing Rate

These columns can also be found in the Bid Review view in Saved views.
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6 . 3 USER-DEF INED IND IRECT COST ITEMS

You may prefer to create your own indirect cost items. You create user-defined indirect cost items the
same way you create direct cost items. The only difference is that your indirect cost items will not be
assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a
parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:
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Add user-defined indirect cost items

Let’s walk through a specific scenario for this step by step.

1. At the bottom of your CBS, create an indirect cost item called Job Overhead with a Forecast
(T/O) Quantity of 1 and Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is 1
Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double-clicking on the row header.

l Assuming there is no Job Trailer in our Resource Rate Register, you will create this
resource “on the fly”.

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

5. On the Resource Rate Register, click the Rented Construction Equipment tab.

6. Right-click on one of the Line Items and select New to add a new resource.
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7. Enter a Resource Code of RJT and description of Job Trailer.

8. In the Amount column enter 25 for the Rented Equipment category.

9. Click OK to close the Resource Rate Record.

10. Select the new resource you created, then click OK to return to the cost item record.

11. On the cost item record, adjust the Job Trailer quantity to 2.

12. On the Production tab, enter 70 days.

13. Click OK to close the record.

14. On the CBS register, select the Utilities cost item by double-clicking on the row header.

15. Create an ad hoc resource on this cost item called Electricity, which will be 1 Lump Sum.

16. Finally, go to the Resource Employment Breakdown tab and enter 1500 in the Custom Category1
row.

17. Click OK to close the record.

6 . 4 COST ALLOCAT ION

The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one or
more other cost items in the Cost Breakdown Structure (CBS) Register.

l Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.

l Allocation Target - A cost item to be the recipient of allocated cost, as defined within the
Allocation Item. There may be one or many Allocation Targets for one Allocation Item.

l Distribution - A read-only cost item in the CBS representing an Allocation Target's
proportional share of the Allocation Item.
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You can choose from several methods to determine specifically where and how much cost to spread:

l Quantity - Specify the amount of the Allocation Item to be spread to each Allocation
Target.

l Proportionately based on another field - Allocate proportionately by one of many
available cost item values, usually based on time or cost.

l Percentage - Specify the percentage of the Allocation Item to spread to each Allocation
Target.

l Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation
Target to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of
determining appropriate bid prices.

Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost items.
A subordinate cost item cannot be allocated, and a cost item that is assigned to a pay item
cannot be allocated.

6.4.1 Cost allocation

With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better
visibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then
compare this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Target
(s).

In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the Unit of
Measure of the Allocation Item. For instance, if the Allocation Item's Unit of Measure is Cubic
Yards (CY), then the caption displayed for this column is CY Quantity.
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A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.

6.4.2 View filter excludes cost Item allocation details

A View Filter option is added to show only the level 1 cost item distribution in the allocation
destinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the
destination cost item by creating a copy of the entire allocated cost items structure. This filter allows
you to simplify the view by displaying only the parent level allocation cost item.

6.4.3 Cost allocation to by Unit Cost

Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.

6 . 5 DEPENDENT COST ITEM ALLOCAT ION

When allocating cost for a dependent cost item, the calculation of the cost item’s subject cost aligns
with the allocation target values (such as values based on quantity, percentage, or unit cost). The
target values are the owner’s target values. This allows you to better manage allocation values.
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When you allocate costs for a dependent cost item that defines its subject costs from other cost items
that include allocation from other cost items and select the option Use owner’s quantities to calculate
cost, the subject cost calculation is based on how the cost items are currently allocated. In other
words, it includes the distributed costs from the allocated cost item.

6.5.1 Turning off cost allocation

If determined that you no longer want to spread the cost of an allocated item, you can turn off cost
allocation for that cost item. To turn off cost allocation, in the cost item record’s Allocation tab,
deselect the Allocate this Item’s Cost check box. The logic that you created to spread the costs are
retained, so you can easily select it again later.

6.5.2 Break cost allocation link

You can break a cost allocation link and make a distribution be a permanent part of the CBS and permit
its costs and quantities to be directly editable under the cost items to which it has been distributed.

Breaking the cost allocation link breaks the link from the cost allocation item to the distribution items,
making the distribution items permanent cost items in their current locations. If the allocation item or
any of its distributions are included as a dependency on a dependent cost item, then breaking the link
could result in a change to the job’s target price. The action cannot be undone.
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Breaking a cost allocation link

1. In the CBS, open the cost item record.

2. In the Actions tab of the record, click Break Cost Item Allocation Link.

3. In the Attention dialog box, click Yes.

6.5.3 Pay item assignment for allocation distribution

In locked jobs, the Allocation distributions inherit target Pay Item Assignment option is automatically
selected and cannot be changed. This is normal Estimate behavior for locked jobs.

In a job that is unlocked, you have the option to select the Allocation distributions inherit target Pay
Item Assignment check box to use the same allocation distribution for the cost item’s costs anytime
the cost item is copied and added to a job.
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Exercise 6.1 — Define indirect costs

In this exercise, you will practice entering Indirect Costs. Complete the following steps, using your
Job:

1. Double click on the Price % Add On row header.

2. You already have Office Overhead as your first line item. In the next blank row type
Corporate Insurance in the Description field and enter a rate of .10.

3. Click OK to close the record.

4. Double click on the Direct Cost Add-On row header.

5. You already have Small Tools as your first line item. On the Description tab, type Safety &
Training in the next blank row’s Description field, then press Tab.

6. The Dependency Cost Breakdown appears on the right. Enter a rate of 5 for Labor Costs
only.

7. Click OK to close the record.

You should end up with similar results like below:
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Congratulations, you have completed this exercise!
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Lesson 6 - Review

1. Default indirect costs are pre-built _____ ______ created by InEight Estimate, located
within the CBS Register.

a. billing rates

b. cost items

c. pay items

2. By default, any cost item you create in the CBS Register that is not assigned to a pay item
is considered indirect cost.

a. True

b. False

3. The cost segment field in the CBS is used to indicate:

a. Whether your costs will be considered job overhead, business overhead, or direct
cost.

b. The source of your costs (Detail, Plug or Quote).

c. What pay item your cost item is assigned to.

Lesson 6 - Summary

As a result of this lesson, you can:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items
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LESSON 7 — QUOTE MANAGEMENT

Lesson Durat ion: 60 Minutes

Lesson Object ives

After completing this lesson, you will be able to:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items

InEight Inc. |  Release 26.5 Page 319 of 419

Estimate User Guide



7 . 1 QUOTE MANAGEMENT OVERV IEW

7.1.1 Quote management workflow

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract, but
rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:

1. Creating and publishing Requests for Quote (RFQs)

2. Updating quotes with vendor/subcontractor pricing

3. Comparing and awarding quotes

InEight Estimate has a separate form to manage each step:

1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award
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7.1.2 Quotes and Quote groups

Typically, an estimate contains two types of quotes:

1. Quotes for resources (materials, equipment) purchased or rented from suppliers.

2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost
item level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

7.1.2 .1 Resource leve l quote groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:
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7.1.2 .2 CBS leve l quote groups

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.

7 . 2 REQUESTS FOR QUOTE

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or
services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the
line items you want to include in the quote, and the vendor(s) to whom you want to send it.

7.2.1 Request for quote (RFQ) Register overview

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

l The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response
Deadline Date
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7.2.2 Request for quote (RFQ) record

You can double-click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing RFQ record.

Name Definition

1 RFQ
Description

Each record contains a Description, Deadline Date and Deadline Time
fields to identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the
quote, terms & conditions, and the seller companies to receive the RFQ.

3 Status and
Published
Data

The Status and Published Date let you know if it is new or published (sent
out), and when it was published.

Overview – Request for Quote (RFQ) Record
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7.2.3 Create an RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

l Create RFQ from scratch:  This creates an empty RFQ Record for you to define.

l Create RFQ from Quote Group Tag(s):  This option lets you create an RFQ from a quote group so
you can add multiple materials or subcontract items at once.

l Create RFQ using Default Seller data:  In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job.

The rest of this section walks through each tab on the RFQ Record in more detail.

7.2.3 .1 L ine i tems

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.

7.2.3 .2 Terms & Condi t ions

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.
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7.2.3 .3 Vendor companies

You will use the Vendor Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the Estimate Library Address Book. This tab will store all
of the pertinent contact information for each seller, including their email address so that you can send
them the RFQ.

The following options are particularly noteworthy:

l Publish Item Quantities:  If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

l Publish To File:  If you choose to Publish To File, Estimate creates a Microsoft Word document
with a template filled out. It is ready to print and send, but you have the opportunity to double-
check the information before emailing the RFQ

When RFQs are generated for multiple vendors using the Publish To File option, be sure to
separate the Microsoft Word document pages and send only the correct pages to each
vendor.
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l Publish by Email:  If you choose to publish by email, the Word document is created, the template
is filled out, it is attached to an email, and automatically sent to the email address listed for that
vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not give you
the opportunity to double check your information before the RFQ is emailed. For this
reason, it is recommended to Publish To File, review the information, and then email the
RFQ manually.

7.2.4 Attachments

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.

7.2.5 Setup

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.
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7.2.6 Publish an RFQ

Once created, Estimate allows you to generate a Microsoft Word RFQ template that can be faxed or
manually sent via email to the supplier or subcontractor.

When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ, To
do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the RFQ
Record ribbon.

Create and publish an RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).
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3. From the Actions tab, click on the New icon to create a new RFQ.

4. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

5. Select the Aggregates quote group from the right panel.

6. Click OK.

7. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 11:00 am).

8. Select the Terms & Conditions tab.

9. Create and type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

10. Type in All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.

11. Select the Vendor Companies tab and click in the first blank row in the Company Name column.

12. Click on the Address book icon, and then select vendors from the Address Book Register.
Alternatively, you can type the vendor name in the Vendor field to enter a known vendor.

13. Click OK.

14. Make sure Publish to File is checked for all vendors.

15. You can uncheck Publish by email for each vendor.

16. Select the sellers to whom you want to send the RFQ.
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l The file automatically opens for you to review. You can either print it or send it in an email
as an attachment.

17. On the Actions tab of the record, select Publish to create your RFQ document.

18. Select the folder to publish to.

19. Click OK to save the RFQ Record.

Page 330 of 419 InEight Inc. |  Release 26.5

7.2 Requests for quote Estimate User Guide



7.2.7 RFQ email draft

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential sub-contractors or suppliers to ensure you have
good quote coverage in your estimate. Email RFQs open as a draft email message, giving the sender,
the opportunity to control specifically what is sent and customize the message before sending it out to
subs and suppliers.

7 . 3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.
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In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.

7.3.1 Sample received quote scope sheet

Name Description

1 Section one Scope item one includes 4 items the subcontractor has considered as
work to be done onsite. You may want to consider adding all 4 items
as individual quotes. Then creating a package identifying these quotes
as on-site work, totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as
work to be done offsite. You may want to consider adding all 3 items
as individual quotes. Then creating a package identifying these
quotes as offsite work, totaling $24,650.

3 Exclusions The subcontractor is showing 9 items they excluded from their scope
of responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.

Overview – Received Quote Scope Sheet
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7.3.2 Quote register overview

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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7.3.3 Quote record overview

The quote record establishes who the vendor is, along with quoted prices and all terms and conditions.
After a requested quote returns, you can either create the quote in InEight Estimate from scratch or
convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each quote record
contains additional fields and options for managing the quote.

Quote records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
quote data like Vendor Qualifications and Special Terms & Conditions.

The image and table show the available blocks and descriptions.

Name Description

1 Header You can include detailed contact information about the supplier or

Page 334 of 419 InEight Inc. |  Release 26.5

7.3 Quotes Estimate User Guide



Name Description

block subcontractor. The detailed contact information automatically fills when you
select the seller from the Address Book. The External Ref field can be used to
access information specific to the bid/quote.

2 Price
block

The Price data block contains a breakdown of pricing information for the
quote, including taxes, item conditions, and special conditions.

3 Quote
tabs

The tabs at the bottom of the page hold detailed information regarding the
quote.

4 Default
Data
Blocks

Data blocks include Special Terms & Conditions, Qualifications, Packages,
Taxes, Vendor's Profile, Setup, and Minority.

You can right-click any existing quote in the Quote Register, and then click Open to access the Quote
Record Register.

In the Quote Record Register, you can select multiple vendors by holding the CTRL key, and then
selecting two or more vendors. After selecting multiple vendors, right-click a selected vendor, and then
select an option from the context menu as shown in the image below.
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7.3.4 Header block

The Header block portion of the page is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote
attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

l Optional Code – A code used to reference the received quote.

l Date – The date the quote is received.

l Source – This is the method by which the quote was received. The options are Email, Fax, Hard
Copy, Phone, and Other.

l Currency – System of money in general use for a particular country..

l Ignore – By ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award page.

7.3.4 .1 Quote records

The Quote record header block includes a vendor field with a searchable address book library register
drop-down list. You can select shared vendor data to populate your quote header record with
Platform’s shared master data.
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Using Platform’s shared data also reinforces accurate Estimate quote reporting. For example, you can
report on which vendors and contacts have been awarded quotes or run a report on how many RFQs
have been sent to select vendors and how many RFQs were returned for certain jobs. Additionally,
using Platform shared vendors makes it possible to report on all activity related to a particular vendor.
Examples include seeing how many subcontract agreements have been executed in InEight Contract,
or how many claims/issues a vendor has been involved with in InEight Change. The predominant value
for Estimate using Platform vendors, along with other InEight applications, ensures that the same
vendors are being used by all applications.

7.3.5 Price block

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.
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7.3.6 Quote record tabs

7.3.6 .2 Resources and cost i tems

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
quantities and units of measure.

l A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

l If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

l Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

l A note field is included for explanation changes

l A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

l You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

Cost i tem tags and user def ined f ie lds

There are 25 tag fields in the Quote Record register cost items tab. There are also 15 user defined
fields that let you sort, filter, and group on selected quote records more efficiently.

For example, you can use tags and user-defined fields to isolate certain cost items, or group cost items
together.
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In the Library foundation setup register, you can use three user defined fields (UDF) in the Quote
Groups tag register to enter certain key information such as responsible party or certain other
attributes for better visibility. If preferred, these UDF fields can be viewed in Quote Compare and
Award forms and Session Recap register. For more information, see Quote group tags user defined
fields.

7.3.7 Data blocks

In the Quote Record item, you can use data blocks that let you customize the layout to focus on data
block tabs that matter most to you. You can select the Default Data Blocks action in the ribbon to
revert to the default setting, which shows all six data blocks. Default data block tabs include:

Default data block tabs include:

l Special Terms & Conditions

l Qualifications

l Packages

l Taxes

l Vendor's Profile

l Setup

l Minority
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The seven data blocks show at the bottom right of the page.

You can move the entire data block, or individual data blocks to other parts of the page. For example,
select the Special Terms & Conditions header row, and then drag the pane to any part of the page.
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You can drop the data block on top of an arrow where you want to land the data block, such as the left
arrow.

Selecting the left arrow places the data block on the left side of the page.

You can also close a specific tab if it’s not commonly used. For example, you can right-click a tab, such
as the Special Terms & Conditions tab, and then select Close.

When selecting Float, the tab remains visible, but unattached to other tabs or data blocks.
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To close a tab and revert to the default tabs, select Default Data Blocks.

7.3.8 Data block tabs

7.3.8 .3 Spec ia l Terms & Condi t ions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.

7.3.8 .4 Qual i f i ca t ions

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
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license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.

7.3.8 .5 Packages

Using the Packages feature lets you logically organize quotes into an arranged collection of like
grouped packaged quotes. You can determine how to enter quotes from subcontractors and classify
them into a package grouping. When you create a package within the Packages block, and give it a
monetary value, you can then assign that package code to one or more quote records. The package
code is limited to three characters.

When comparing various vendor quotes in the Quote Comparison and Award form, with each quote
containing its own scope of work, you can easily distinguish which items belong to each package. This
helps to identify which quotes to award in your decision-making process.
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As an example, the following Civic Center Parking Structure quote has three packages defined in it. The
P1, P2, and P3 on the left represent the grouped package numbers that will be used to determine the
package structure in the quote record. The vendor that submitted this quote shows detailed estimates
defined for each of the three packaged items, but there is no breakdown provided in the quote of how
much each line item is worth. Rather, this quote is showing a package price for each collection of items
(scope of work).
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Estimate's Package feature lets you pick all the cost items that belong to a particular package, then
assign the price to that collection of packages. It then proportionally distributes the total package price
across all of the corresponding cost items when comparing and awarding.
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Create a multi-packaged quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double-click an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.
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5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the page.

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2
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l Description: Off Site

l Amount: $300,000

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated
package quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right-click context
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menu.

7.3.8 .6 Taxes

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.
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7.3.8 .7 Sel ler ’s pro f i le

The Seller’s Profile tab populates with address book notes and alternate contact information.

7.3.8 .8 Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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7.3.8 .9 Minor i ty

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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If any of your Data Blocks become deleted on a Quote Record, simply click the Default
Data Block icon.

7.3.9 Create a quote from RFQ

Walk through the steps of creating a quote from an RFQ.

To create a quote from scratch, click the New icon on the Quote Register and fill in the quote
details and seller fields manually.
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Create a quote from RFQ

This exercise walks through a specific example using the Training Job.

1. From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).

3. Open the RFQ record for which you’ve received quotes.

4. Select the Vendor Companies tab, and then select the vendors for whom you need to create
quotes. In this case, select all the vendors.

5. From the Actions menu, select Create Quote.

6. Click OK on the Quotes created prompt.

7. Close the RFQ record and the RFQ register.

7.3.10 Enter quote details

Now that you have quotes created, you can enter pricing.

Enter quote details

This exercise walks through a specific example using the Training Job.

1. To open the Quote Register, select Quote from the Estimate landing page.

2. Select Quotes from the Quote Management section.

3. Open the Aggregates Quote Record for Vendor 1 – Pat Roberts.

4. On the Resources tab, make sure No Split is unchecked for all items.

5. Also on the Resources tab, enter the following unit prices:

Resource code Description Unit price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

6. Click OK to close the Quote Record.
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Create a multi-packaged quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double-click an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.

6. Click OK

7. Select the Cost Items tab on the left side of the page.
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8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

l Code: P1

l Description: On Site

l Amount: $200,000

l Code: P2

l Description: Off Site

l Amount: $300,000
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11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated
package quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right-click context
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menu.

7.3.11 Use unit price or extended price on quote record item

It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which
makes entering quotes more efficient and results in less errors.
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7.3.12 Duplicating an existing quote

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

Duplicate an existing quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

Page 360 of 419 InEight Inc. |  Release 26.5

7.3 Quotes Estimate User Guide



l The resources and prices from the quote you previously selected have been copied
into a new Quote Record.

6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

l Check the default data blocks for any information you want to add to your duplicate
quote.

8. When completed, click OK.
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Exercise 7.1 — Quote management

When you receive quotes from vendors, you will need to record their pricing and conditions in their
Estimate quote records. In this exercise, you will practice entering quote details. Enter the following
quote record details, using the Training Job:

Quote Name:
Aggregates

Seller Name: Example Vendor 2 - Stan Mark

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)

Special Instructions Seller is NOT willing to split items.

Quote
Name:
Aggregates

Seller Name: Example Vendor 4 - Lester Slim

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with similar results like below:

Congratulations, you have completed this exercise!
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7 . 4 QUOTE COMPAR ISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to
determine which is the preferred vendor or contractor to carry their pricing in your estimate. The
Quote Comparison & Award forms improve visibility into comparative analytics, while increasing
efficiencies in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

7.4.1 Quote comparison and award overview

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award. The table
and image below show an overview of the Quote Comparison and Award form.

Name Definition

1 Resources and
Cost Items Filter

You can show either your quoted resources or cost items.

2 Quote Group
Filter

This section provides checkboxes to further filter your items. The
Quote Group Filter allows you to mark the quotes as reviewed.

3 Quote
Description and
Vendor

Your quotes show with the vendor name plus the quote description.

l Awarded items have an award symbol
If an item is designated as No Split, it has a chain link icon

l Awarded and Locked items have a lock symbol next to the

award symbol

4 Cost Source
Type

The cost source can either be a Plug or Detail type.
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d

7.4.1 .1 Select mul t ip le i tems

You can use the CTRL key to select multiple cost items in the selected quote groups, and then right-
click a selected item to make awards using the context menu.

Similarly, you can use the CTRL key to select multiple rows, and then right-click a selected row to copy
and paste to Microsoft Excel, or other applications.

7.4.1 .2 Expor t quote compar ison and award

The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like
at any point throughout the bid closing. Some estimators rely on such bid leveling information but do
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not want to access live information directly in the application, making it crucial to produce an identical
output file of the Quote Compare & Award form at any given time.

You can export the Quote Comparison & Award form to a Microsoft Excel file. In the Quote
Comparison & Award form, go to Actions > and then click the Export to Excel icon. In the Export
spreadsheet to dialog box, select a location to save the file, enter a file name, and then click Save.

7.4.2 Edit mode

You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.
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7.4.3 Substitute values

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.

When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

You can tell when it’s a substitute value because the price displays in italics.

InEight Estimate grabs the substitute value from one of four places:
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1. Awarded splittable quote

2. Lowest splittable quote you’ve received

3. Detail (this only applies to quoting cost items)

4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute
value it displays the vendor whose substitute value has been used.
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When you use a substitute value, it is included in your Comparable Total so you can have a more
realistic comparison of your quotes.

7.4.4 Display ignored quotes

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right-clicking on the subcontractor header, and then selecting Edit Quote.
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From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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Alternatively, you can select Ignore Quote from the context menu when you right-click the
subcontractor header.

If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote
cannot be awarded. The ignored quotes get appended to the right end of the QC&A form.

7.4.5 Export quote comparison and award to Microsoft Excel

The Microsoft Excel file generated when you export the Quote Comparison & Award form closely
resembles the form in Estimate, so users of this output can more clearly understand what the
estimators knew when they made determinations on which numbers to carry.
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The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like
at any point throughout the bid closing. Some estimators rely on such bid leveling information but do
not want to access live information directly in the application, making it crucial to produce an identical
output file of the Quote Compare & Award form at any given time.

To create the Quote Comparison & Award Excel file, click on the Export to Excel icon. Enter a file name
for the Excel file, and then click Save.

InEight Inc. |  Release 26.5 Page 371 of 419

Estimate User Guide 7.4 Quote comparison & award



7.4.6 Additional quote comparison and award functions

The Quote Comparison & Award form contains other notable functions which improves the process of
selecting the quote that brings the greatest value to the estimate. The following image and table show
an overview of the notable functions.

Name Definition

1 Asterisk next to
Quote Item

An asterisk (*) is shown on a quote to indicate when that quote
includes quote items showing in other Quote groups.

2 Zero value
Plug/Detail

Award quotes to Plug or Detail when its value is zero.

3 Updated Quote
Items Tool tip

Quote Item Tool tip shows details including:
l Unit Price
l Extended Price
l Bond
l Taxes
l Special Conditions
l an indicator for a delta quote item

7.4.7 Configure totals

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.
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The Options radio button give you better control for viewing totals at the tops of the screen or after
the quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.
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7.4.8 Adding notes to quote comparison and award

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
quote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.

Add the Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the
next steps.
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3. Select the Actions tab.

4. From the View section, select the Configure Totals icon, and then select the check box in the
Visible column for the Notes Caption.

5. Select OK.
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l The Notes section shows on the Quote Comparison & Award form.

7.4.9 All quote groups layout

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

You can make appropriate quote group selections based on understanding how choosing a quote
group impacts the entire estimate. In addition, the quote groups layout provides you with the visibility
and flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

The following image and table show the features of the All Quote Groups layout:
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Name Definition

1 Totals per Quote
Group

View the Awarded Total Plug, Detail and Quote amount per Quote
Group.

2 Total Awarded
Amount

Visibility into the Total Awarded Amount per Quote Group.

3 Expand/Collapse Expand and collapse individual or All Quote Groups to show the
quote items.

4 Comparable totals Better visibility into the Comparable totals per Quote Group.

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

7.4.10 Compare and award quotes

To award an item, right click on that item and select Award.
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The Award icon displays next to the awarded item(s).
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Once you award a quote in Estimate, you can see it adds the Awarded Total on the comparison page,
and the pricing updates automatically in the Cost Breakdown Structure.

You can award multiple Quote items by selecting all the items and then using the right click
context menu to award.

7.4.10.3 Open sta tus

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
quote record, will turn the record back to gray.

7.4.10.4 Award sta tus

The Award Status indicates whether or not all quotes are awarded within a quote group.
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7.4.10.5 Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
quote group will be highlighted in yellow to indicate something changed since the last review.

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

Compare and award quotes

This exercise walks through a specific example using the Training Job.
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1. From the main Estimate landing page select Quote>Quote Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.

3. Under Quote Groups, select Aggregates.

4. Review the quotes to determine the lowest bidder:

l MDIRTB is marked as Free for Example Vendor 4 and their quote is not splitable.

l Vendor 2 Stan Mark did not give a quote for MDIRTB, so a substitute value is being used.

5. Vendor 2 has the lowest comparable amount for MBR Aggregate Base Rock and Vendor 1 has
the lowest comparable amount for MDIRTB, so you decide to award each respectively. Award
each of them by right-clicking on the value and selecting Award.

6. On the attention prompt click Yes.

7.4.11 Package entire quote

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial if
you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.
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The Package Price can quickly be modified in the Quote Comparison & Award form by selecting the
Edit Package action in the Actions tab or by using the right-click context menu.

7.4.12 Incomplete quotes

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not
provide their prices until right before the bid is due. These quotes display in gray in the Quote Compare
and Award form.
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Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes show to the
right of all the Comparable Quotes.

7 . 5 SCOPE ITEMS

During the bidding process, it’s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items,
you can create and evaluate checklists and quote group exclusions, and account for them within the
Quote Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Section Description

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting the checkbox,
you can indicate scope items and uncheck items that are not included. The
amount associated with these items will then total up in the Special Conditions
subtotal. The person responsible for awarding quotes needs to update the
Inclusions field to correspond with what the subcontractor has agreed to include
in the quote.

Overview – Quote Record – Scope Items
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Section Description

1 Scope Items Quote Comparison and Award checklist items for your quote that help
with evaluating subcontractor and supplier quotes in greater detail. This
is used to ensure certain items are either included (inclusion) or excluded
(exclusion) in the quote and accounted for by the entity awarding the
quote.

2 Scope Item
Inclusions

Maintained in Quote Record form. These are the Seller’s Special Terms
& Conditions scope items that the subcontractor is including in their
quote price. When the scope item contains a value, the subcontractor is
agreeing to perform the work.  

3 Scope Item Maintained in Quote record form. These are the Seller’s Special Terms &

Overview – Quote Comparison and Award – Scope Items
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Section Description

Exclusions Conditions scope items price. If the Inclusions checkbox is blank, the
subcontractor is NOT agreeing to perform the scope items.

4 Scope Item
value

An entered value means that the subcontractor is excluding this scope of
work. However, you may add an amount because this scope could incur
a cost. Once the bid is awarded, you may find another subcontractor to
perform the work. You are simply accounting for a cost for this scope of
work. In the example below, HD Engineering is not going to paint the
electrical equipment, but you know the cost is $150.00. You are showing
this cost to account the cost for this scope of work that needs to happen.

5 Vendor's
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the
Special Conditions amount is $0.00. On the quote record, by selecting
this checkbox, you can indicate scope items and uncheck items that are
not included. The amount associated with these items will then total up in
the Special Conditions subtotal. The person responsible for awarding
quotes needs to update the Inclusions field to correspond with what the
subcontractor has agreed to include in the quote.

Overview – Quote Comparison and Award – Scope Items (continued)

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best
value. In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the
best quote to go with.
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The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

7.5.1 Scope item setup

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each
Quote Group Tag Record, you can list out scope items that break down the work into smaller scopes of
work, along with the estimated cost amount associated with each scope item.
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Set up scope items

This exercise walks through a specific example using the Training Job.

1. Open your job.

2. Select the Setup tab.

3. Click on Foundation Data Setup in the Initialize section.

4. Select the Quote group tags tab to set up scope items within a quote group.

5. Create a new Quote Group Tag called Electrical Work and click Ok.

6. Open Electrical Work and add the following scope items:

l Permits

l Surveying and Layout

l Temporary Traffic Control Devices

l Trench and Backfill for Electrical Work

l Painting Electrical Equipment

l Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and a 300 for Temporary Power and
Lighting.
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8. Click Ok.

Set up quotes for scope items

This exercise walks through a specific example using the Training Job.

1. From the Estimate tab, click on Cost Breakdown Structure (CBS).

2. Change your saved views to Quote Group Setup view.

3. Create a cost item Entry Gate with a subordinate Electrical Work.

4. Assign the Electrical Work quote group to the Electrical work cost item.

5. From the Quote tab, click Request for Quote (RFQ) to open the RFQ register.

6. Create an RFQ by selecting the New icon on the Actions tab.

7. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.

8. Click Ok.

9. Click on the Vendor Companies tab and select the following company names:

l Architectural Designs

l HD Engineering Group
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10. Highlight both companies and select Publish.

11. Assuming you’ve already received quotes back from both companies, create a quote from this
RFQ for both companies by selecting the companies and selecting Create Quote.

12. Click Ok to close the RFQ record.

7.5.2 Scope item creation and award

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

Manage and award scope items

This exercise walks through a specific example using the Training Job.

1. Click the Quote tab and then click the Quotes icon to open the Quote register.

2. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500 which is based
on the quote you received.

3. Select the Special Terms & Conditions tab and select the Seller's Special Terms & Conditions
radio button.

4. Assuming the HD Engineering is excluding certain scope items from this quote, click on the
Included checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment
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l Temporary Power and Lighting

5. Type 150 in the Amount field for Electrical Equipment.

l Notice how the 3 scope items you just excluded are now added to the Special Conditions total
for the quote.

6. Click Next to move to the other Quote record for Architectural Designs.

7. Enter a Unit Price of 3,700.

8. Press Tab to move to the Special Terms & Conditions tab and select the Seller's Special Terms &
Conditions (at right) radio button.

9. Uncheck the inclusions checkbox for Surveying and Layout.

10. Add the amount 500.

11. Click Ok.

12. Select the Quote tab.

13. Open the Quote Comparison and Award form, and select the Cost Items tab.

14. Under Quote Groups, select Electrical work.

15. Right-click on the quoted amount for Architectural Design and select Award to award the work
to them.

16. Click Yes on the resulting prompt to mark the quote group as reviewed.

7 . 6 QUOTE ITEM ADJUSTMENT

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on
piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the
Condition Adjustment column.

Quote item adjustment

From the Ribbon, select the Quote tab.

1. Under the Quote Comparison and Award section, select Resources.

2. Locate a Vendor column.
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3. Select the quote you want to edit under the vendor column. In the Ribbon, select the Actions
tab.

4. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

5. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust
the percentage or amount of the Condition Adjustments.

6. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

7. If you populate a 10% discount adjustment to all of the items selected using the multi-edit tool,
the amount value changes to “Varies”. This is because of the variance in the unit rates for each
selected item.

8. Click Ok to save the changes to the line items in the Quote record and to save the Quote.
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Lesson 7 - Review

1. When you receive responses to your RFQ, the next step is to enter their pricing in the
__________________.

a. CBS Register

b. PBS

c. Quote Register

d. RFQ Register

2. On a Quote Record, No Split means

a. The quote must be combined with other quotes from the same vendor

b. All items on the quote must be purchased from that seller

c. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in gray on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed

b. No quotes have been awarded for that quote group

c. There are some quotes in the quote group that contain substitute values

Lesson 7 - Summary

As a result of this lesson, you can:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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LESSON 8 — F INAL IZE THE
EST IMATE

This lesson is primarily suited towards contractors who must add profit or markup to their total
estimated cost, which will be submitted in the form of a bid or proposal. Most owners can divert from
this lesson as it's more geared towards adding profit and markup. There are a few use cases in which
an owner may wish to use the price breakdown structure. For example: to add risk, contingency, or
reserves if it is preferred, these are not shown directly in the budget line items. The price breakdown
structure also provides a summary level review of the total estimate and is a great reference during
estimate reviews.

Lesson Durat ion: 45 Minutes

Lesson Object ives

After completing this lesson, you will be able to:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments
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8 . 1 JOB MARKUP (PROF IT )

On the Data Map notice how the different segments within the pyramid coincide with the
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. Illustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

8.1.1 Target price

For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.

The images below represent a default examples.

On top of your direct costs, you can decide if costs with a cost segment of business overhead should be
indirect costs or markup. You estimate your direct and indirect costs in the CBS Register.
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At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown
Structure (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of
Indirect Cost Markup.

The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.
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8.1.2 Price breakdown structure

As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.

The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.

Name Definition

1 PBS
Description

The left side of the screen displays several cost classifications:
l Target Profit
l Business Overhead
l Job Overhead
l Direct Cost

2 Various
Columns

The Assigned and Unassigned columns show which costs are either
assigned or not assigned to pay items. Unassigned costs are spread back
to pay items based on the distribution logic set in Job Properties > Pricing.
The Total columns represents a summation of both columns.

Overview – Price Breakdown Structure
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Name Definition

Each layer displays with an amount, and the percentage of the Target
Price that this amount represents.

3 PBS Menu The right side of the screen holds several tabbed pages of information.
This information is useful in analyzing the job at a summary level.

4 Refresh
Data

To ensure that you are always reviewing the most up-to-date factors and
ratios, click the Refresh Summary Data button whenever you are
reviewing the data.

Overview – Price Breakdown Structure (continued)

All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-off
quantities).

8.1.3 Markup vs. Margin

Let’s look at the difference between Markup and Margin.

l Markup is a function of cost, while margin is a function of price

l Markup indicates how much you are marking up the cost

l Margin indicates what percentage of your price the markup represents
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The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.

When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

Within Job Properties, you can choose if costs with a cost segment of business overhead should be
indirect costs or markup. If selecting markup, then Business Overhead will be spread within the
Markup category of the Price Breakdown Structure. The Total Markup will be the sum of Target Profit
and all Items categorized as Business Overhead.

This lets you see the true total cost of the job, including the total markup inclusive of the business
overhead. You can also create cost items and categorize them as business overhead, then possibly
include overhead costs such as estimating or home office expenses. This provides you with added
flexibility in marking up your job.

8.1.4 Define profit

Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated
some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price
Breakdown Structure. Notice you have not defined profit yet.
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You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or
Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.

8.1.4 .1 Prof i t as a percentage of target pr ice

Add profit as a percentage of target price

1. Open your job.

2. Select the Price tab.
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3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.

4. On the Target Profit row, enter a numeric value in the % of Target Price column; press Tab.

l For this example, we’ll add 10% for the Target Profit.

8.1.4 .2 Prof i t th rough di rec t cost markup record

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.

Modify the direct cost markup record

1. On the PBS form, double-click on the Direct Cost Markup row.

2. In the record, overwrite the Default entry with Direct Cost Markup in the description field.

3. In the Rate column on the Dependency Cost Breakdown, add a numeric value in Labor, Owned
Equipment, Materials and Fees categories. Then reset other categories back to 0.

4. Click Ok to save your changes and return to the PBS.

5. Click the Refresh Summary Data button to see the changes reflected.

l For this example, we’ll add a rate of 15 for Labor, 10 for Owned Equipment, 8 for Materials, and
2 for Fees, then zero out all other categories.

8 . 2 COST EST IMATE AUD IT /REV IEW

InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.
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8.2.1 Price breakdown structure tabs

The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

8.2.1 .1 Markup analys is

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have
enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.

8.2.1 .2 Cost source

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the
amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost
source should be the lowest percentage.
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8.2.1 .3 Resource ut i l i za t ion

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on
the job, based on take-off quantities.

8.2.1 .4 Subcont rac t s ta tus

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
quoted cost items. This is a good place to review how much of your estimate is subcontracted.

8.2.1 .5 Vendor s ta tus

The Vendor Status tab displays a breakdown of vendor information, including amounts and
percentages of the Target Price represented by vendors. This is a good place to review how much of
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your estimate costs come from vendor quotes.

8 . 3 SPREAD TARGET PR ICE OVER PAY ITEMS

In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price
Breakdown Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

8.3.1 Current price vs. Target price

In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Item & Proposal).

At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.

InEight Inc. |  Release 26.5 Page 403 of 419

Estimate User Guide 8.3 Spread target price over pay items



8.3.2 Proposal recap

On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your
Current Price to your Target Price to see if there is any variance.

Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.

Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

8.3.3 Spread the target price

For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined
by the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:

1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.

8.3.4 Define pricing for pay items manually

First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.
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Define pricing manually

1. From the Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.

3. Select a Pay Item row.

4. In either the Unit Price (current), Total Price (current), or % Margin field of a pay item, type a
numeric value.

For this example, we’ll do the following:

l Mobilization pay item – change Total Price (current) to $20,000.

l Clearing & Grubbing pay item – change % Margin to 5%.

8.3.5 Use AutoPrice to balance and hit the target total

Perhaps you want to get a head start and have InEight Estimate spread your Target Price
proportionately over your pay items for you. This can be done using the InEight Estimate AutoPrice
feature.

Once distributed, you will still have the ability to adjust your pricing on pay items manually as
needed.

Look at how you can use the AutoPrice feature.

Use AutoPrice to balance and hit the target total

1. Open the your job in Estimate.

2. From the Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.
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4. On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.

8.3.6 Use AutoPrice to unbalance and hit the target total

The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it
strategically between these items.

Unbalance bid

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your
job.

2. If you do, highlight the row for each item to view it’s current balanced item recap.
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3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

l You will see the changes reflected and how the profit was spread to your overrun and
underrun items

l In the example shown, highlighting each item will show that all your overhead and
profit from Excavation was put onto Clearing & Grubbing.

8 . 4 SELECT IVE PAY ITEM MARKUP

Estimate has a streamlined process to estimate the cost of a project and price the work to ensure all
unassigned costs and markup are included in the final price of the project. For markup to be spread to
pay items, a weighted distribution method is used as determined in the Job Properties, Pricing tab. It
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might be desirable for markup percentages to not be distributed, but rather directly applied to the
costs assigned to any particular pay item.

This option can be set to keep markup with assigned costs for establishing a pay item price.

Additionally, this option can be used to isolate the markup and apply it only to specific pay items. The
following is an example of a dependent cost item being used to mark up the labor of select site work
pay items by 25%.
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8 . 5 B ID ADJUSTMENTS

Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

8.5.1 Lock price

You can lock down a pay item price and it will not factor in future rebalancing.

Lock price

1. Select the Lock Price checkbox on an item's row.

2. After making further adjustments in the next step by step, you will return to the Pay Item &
Proposal to rebalance.

l You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

l For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

Make last minute bid adjustments

1. With your job open, select the Estimate tab.

2. Click on Cost Breakdown Structure to open the CBS.

3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.
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4. Under the Description tab on the left, click in the blank row under the Description column.

5. Type in a description.

6. Make the adjustment by typing a numeric value in the Cost column of the Materials Cost
category under the Cost Breakdown section on the right.

l To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

8. Finally, return to the Pay Item & Proposal.

9. On the Actionsmenu, select Balanced Bid > Hit Target Total.

10. An Auto Price Warning may display, informing you of rounding variances. After reading the
details, click the Close button.
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l Note on the proposal recap that a variance may still exists because there are limited
number of pay items to spread the rounding error over

l Note that the locked item did not adjust, but the other pay items were updated

l Note that you can overwrite locked items for spreading your price by checking the
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Overwrite Locked Pay Items option on the Actions menu

8.5.2 Suspend pay items

Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal
Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the
estimate.

This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to
no longer contribute any cost or price. It will no longer show up on your bid and no longer contribute
to the overall total price.

You can suspend or unsuspend pay items in one of three ways:

l Right-click on the pay item, and then select Toggle Suspended.
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l Select the pay item and click Toggle Suspended under the Edit section of the Actions Tab.

l Open the pay item record, and then select or deselect the Suspend check box.

8 . 6 AUTO PR ICE BALANCED B ID OPT IONS

To determine the final pricing of your pay items on the job, you can use one of the following two
options in Auto Price > Balanced Bid:

l Hit Target Total

l Use Item Unit Price

These Balanced Bid options are a simple way to have the Estimate automatically balance the bid,
spreading your cost, overhead, and profit proportionately across your pay items. This can be a great
starting point for finalizing your bid, with the understanding that, once balanced, you can still make
your own adjustments to pay items manually.

You access the Balanced Bid options from the Actions menu of the Pay Item & Proposal Register.
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8.6.1 Considerations

l Pricing Options - Prior to using the Auto Price feature, pricing options should be considered.
These can be configured as a default for all jobs from Library > Job Properties, or for an
individual job in its own Job Properties.

See Library Job Properties Pricing for more information.

l Rounding Precision - The Rounding Precision option is an important factor to consider when
using Auto Price to balance your bid, as it can influence how pricing is or is not spread to a pay
item based on what decimal the item’s unit price is rounded to.

In the Pay Item & Proposal Register, you can define the rounding precision at the pay item level
using the Rounding Precision column. For more information, see Rounding Precision.

8.6.2 Hit target total

The Hit Target Total option is the same as the Use Item Unit Price option, though it goes the extra step
and tries to spread the variance (if there is any) back over your pay items.

In most cases, selecting Balance Bid > Hit Target Total results in all the rounding variance being spread
over your pay items successfully. The following use cases explore situations where some variance
might remain.

8.6.2 .1 Large quant i ty pay i tems

When adjusting the pricing of pay items to absorb rounding variance, even minor adjustments to the
unit price can result in a large change to the pay item’s total price if it has a large pay quantity. For
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example, cutting $.01 from a lump sum pay item has very little effect when compared to a pay item
with a pay quantity of 50,000.

Pay Item
Pay

Quantity
Unit of
Measure

Unit Price
Adjustment
Amount

Total Price
Adjustment
Amount

Rounding
Precision

Mobilization 1 Lump
Sum

$0.01 $0.01 2

Excavation 50,000 Cubic
Yards

$0.01 $500.00 2

Depending on the amount of variance that needs to be spread and the pay quantities of your unlocked
pay items, Estimate might not be able to spread all your remaining variance.

For example, if your remaining rounding variance is $200.00 and Estimate only has high quantity pay
items to spread to like the Excavation pay item in the above example, it would not be able to adjust
the pay item by only $200.00.

8.6.2 .2 High rounding pay i tems

When balancing the bid, the higher the rounding precision of your pay items, the less variance there
will be, and the more likely Estimate will be able to spread the variance back over your pay items.

For example, a bid that has a rounding precision of 2 (two to the right of the decimal or to the penny)
for all the pay items in the bid will typically have no remaining variance when using Balance Bid > Hit
Target Total, because any rounding variance from the initial balancing can be absorbed by making
minor adjustments to the pay items’ unit prices.

If the bid includes a pay item that has a lower rounding precision, that pay item might not be able to
absorb variance because of the rounding precision assigned to it.

In the below example, the pay item’s rounding precision is set to -2 (two to the left of the decimal or to
a hundred. If the Estimate needs to add $49 to this pay item to balance the bid, it will not be able to
since its precision is set to round back down to $18,500.
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8.6.2 .3 Low number of ava i lab le pay i tems

If your bid has a low number of pay items to spread variance to, either due to a low number of
deliverables, or to a small number of unlocked pay items, this leaves less opportunity for Estimate to
spread the remaining variance successfully.

8.6.3 Use item unit price

The option Balanced Bid > Use Item Unit Price can best be thought of as use the item’s balanced unit
price for balancing the bid. When this option is selected, the following takes place:

l All assigned costs are distributed to pay items based on the cost items assigned to them.

l All unassigned costs are distributed to pay items proportionally according to the weight of the
pay items’ assigned costs and the level selected for distributing unassigned costs on the Job
Properties > Pricing tab (Individual Categories, Top level Categories, or Total Cost/Billing
amount).

l Markup is applied to pay items according to the markup options selected on the Job Properties >
Pricing tab.

See Balanced Price Options in Library Job Properties Pricing for more information.

After balancing, when you select a pay item, on the Item Recap section you can see the Unit Price
(current) now matches the Unit Price (balanced), indicating the pay item is using the balanced unit
price.
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As Estimate calculates the balanced unit price for each pay item, it follows the rounding precision
defined for each pay item. As it rounds pricing up or down based on this precision, a variance from the
Target Price might occur. You can see this variance on the Proposal Recap section, with an indication of
whether you need to cut or add money to reach the Target price.
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Lesson 8 - Review

1. Markup is a function of cost, while margin is a function of _________.

a. billing

b. price

c. job overhead

d. indirect costs

2. When adding profit, it must be the same amount for direct and indirect costs.

a. True

b. False

3. What options do you have to enter profit on the PBS?

a. %Mark-Up, % Margin, and Fixed Dollar Amount

b. %Mark-Up or % Margin

c. Fixed Dollar Amount Only

4. Once distributed, you still can adjust your pricing on pay items manually as needed.

a. True

b. False

Lesson 8 - Summary

As a result of this lesson, you can:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments
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